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Introduction 

Welcome to Microsoft Retail Management System, Store Operations 

Welcome to Microsoft® Retail Management System, Store Operations. Whether you 
have a single store or multi-store operation, you can use Store Operations to automate all 
your point-of-sale (POS) and back-office applications. 

Store Operations gives you the only total software solution that handles today's POS and 
management challenge...then grows as big as your goals expand. Store Operations 
resolves the complexities of multi-channel retailing, providing a common system to 
manage sales through physical stores, catalogs, phone orders, and the Web. 

Store Operations manages every aspect of your brick & mortar store with complete 
security and absolute control. The software flexes to the way you sell, learns how you 
manage, equips you with the same tools that retail giants use, and gives detailed, blazing 
fast reports on exactly what's happening in every department, for every item. 

When you expand to the Web, Store Operations has already paved the road. Manage all 
your sales, inventories, customers and records in one easy package. As you expand, keep 
the same database, the same interface. Both will scale up seamlessly. You and your staff 
keep the same powerful Store Operations tools with no retraining. 

Store Operations incorporates three separate programs: 

! Store Operations Manager - Automates back-office operations, including 
purchase order creation, receiving inventory and printing price tags/labels, customer 
database maintenance, and report generation. Beyond basic inventory control 
features, its advanced capabilities promote optimum inventory levels, control costs, 
and set pricing. 

! Store Operations POS - Provides the graphical user interface and handles all the 
point-of-sale functions at the checkout terminals. It allows the cashier to ring up 
sales, perform data lookup, accept tenders, and generate work orders, back orders, 
and quotes. It supports multiple POS devices (i.e., scanners, printers, pole displays, 
etc.) 

! Store Operations Administrator - Lets you connect to the database server, 
create databases, import existing QuickSell databases, upgrade the database, back up 
data, and configure the Store Operations database for each of the point-of-sale 
registers.  
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Getting started 

Starting and quitting Store Operations 

The following explains how to start and quit the Store Operations Manager and POS 
programs. 

Starting Store Operations 
You can start Store Operations by running either the Manager or POS program from the 
Windows Start menu. You will then be asked to log in. Use the user ID and password 
provided to you by your Store Operations administrator to log in. The user ID will be 
used by the system to validate the password and to determine your rights for accessing 
the data stored in the database. To run the Manager program, you must log in with a user 
account that has been granted manager rights. 

When a Store Operations database is created, a default user account is automatically set 
up to allow you to log in and perform initial database setup. This account's ID is "1" and 
its password is "PASSWORD". Use this account ID and password to log in as shown as 
follows. After you set up your database, you should then change the password. 

 

Quitting Store Operations 
To exit the Store Operations POS program, press the ESC key until you see a window 
that asks if you really want to close Store Operations POS. Select the appropriate button. 

Note: Only cashiers with the privilege to exit the point-of-sale may fully quit from Store 
Operations POS.  

To exit the Store Operations Manager program, go to the File menu and click Exit. 
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Key information 

Using Microsoft Retail Management System for the first time 

! You must install the Store Operations software copy protection device ("dongle") 
either on the register's parallel port or in a networked configuration. Install the 
dongle on the first POS station that will run Store Operations POS each business 
day. 

! When installing the software, Store Operations creates a default cashier with the ID 
number "1" and password "PASSWORD." Use this combination to initially log 
onto Store Operations Manager. You can then change the ID number and password 
as applicable. 

! When Store Operations is initially installed, a sample database is provided to allow 
the software to run immediately. This database contains skeletal information for a 
fictitious store that you may use to learn about Store Operations’s features. You may 
modify this database. For instructions on how to load the sample database, refer to 
Store Operations Online Help. 

! Before you can process sales at the point-of-sale station, you need to set up and/or 
modify the Store Operations database. For more information, refer to the Setting Up 
Your Store Operations Database section.  

Upgrading from QuickSell 2000 or QuickSell Commerce to Store 
Operations 

! Before upgrading to Store Operations, you must make sure that your existing 
computer and POS devices meet the minimum requirements to run Store Operations. 
You will need to obtain OPOS service objects for your existing POS devices from 
the hardware manufacturers. Make sure that you back up your existing QuickSell 
installation before installing the new software. 

! After you install Store Operations, you need to install and set up your database(s). 
You can upgrade your existing QS2000 or QSC database to work with Store 
Operations. For detailed information on how to upgrade your database to Store 
Operations, refer to the Upgrading from an Existing QS2000 Database section in 
Store Operations Administrator Online Help. 

! Because Store Operations incorporates a number of new and enhanced features, it is 
a good idea to review the What's New section. 
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What's new 

Overview 
Store Operations is packed full with exciting and advanced features that revolutionize the 
way you process back-office and POS activities. These include: 

! Advanced security features - Incorporate tight security controls and restrict 
employee access to sensitive information in both the Manager and POS programs. 

! New database technology - Use the latest Microsoft SQL Server technology. 

! Internet applications - Incorporate a Web-browser, Internet communications 
services, XML support, and virtual private networking. 

! OPOS compatible - Use Store Operations with OPOS compatible hardware. 

! Touchscreen capabilities - Obtain key database information literally at your 
fingertips. 

! Net Display channels - Display advertisements and websites on another monitor at 
your point-of-sale station. 

! Customizable Active Reports - Fine-tune a wide variety of consolidated reports. 
Customize and sort data directly on the report preview screen. Access detailed 
database information directly from the reports. 

! Inventory Wizard - Change item and pricing properties in your database...all at one 
time. 

! Receipts with logos and graphics - Customize your point-of-sale receipts. 

! Label Designer and Label Wizard - Speed up the way you process and use labels. 

! Shipping and tracking - Operate mail order houses from the same store inventory. 

! Customizable POS buttons - Access other software program tools and websites 
without leaving the point-of-sale transaction screen. 

! New Item Wizard - Quickly add items to your database. This feature is especially 
useful for entering assembly, matrix, and lot matrix items. 
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! Retail price rounding - Round updated global prices to realistic retail price values. 

! Flexible tax structures - Assign tax based on the item or the customer. This feature 
enables you to handle mail order. 

! Extended inventory management - Track the history of item quantity changes and 
shipments, store offline inventory, and generate receiving logs. 

! Customizable POS screen - Pick and choose the display features you want to show 
on your point-of-sale transaction screen. Adjust the screen size and positioning. 

! Aged receivables feature - Process and track customer payments by individual 
invoices. In addition to setting up revolving accounts, use the aging accounts 
receivable capabilities to bill payments for net terms. 

! Vouchers - Offer a dynamic gift certificate or gift card to your customers. 

! Detailed customer account information - Look up detailed customer account 
information for each invoice, make adjustments, and print the applicable receipt. 

! Master pack quantity - Define the bundle quantity for selected items, and Store 
Operations will automatically use this number for purchase orders. 

! Enhanced Journal Viewer - View and print any journal from any register in your 
preferred format. Search journals by register, batch number, and receipt number. 

! Unlimited line item entry - Ring up an unlimited number of items on the POS 
transaction screen. 

! Improved orders, quotes, and layaways - View and edit detailed order, quote, and 
layaway information directly on the transaction screen. Assign reference numbers 
and accept payment on an item-by-item basis. 

! Editable time clock capabilities - View and edit time clock entries directly in the 
Manager program. You can also restrict cashiers from viewing or editing these 
entries. 

! New assembly, matrix and lot matrix features - Organize all of your assembly 
and matrix item information into a comprehensive grid. View and edit any of the 
item attributes directly on the grid. 

! Detailed graphs - Customize your own graphs according to various time periods, 
categories, departments, registers, hourly counts, etc. See your data in numerical and 
graphical formats. 
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! "Buy X, Get Y" discount capability - Sell a specified quantity of items at full 
price and give the customers a certain number of items for free or at discount. 

! Foreign currencies - Utilize new multi-currency features to enhance global 
commerce operations. 

! Reason codes - Customize reasons codes to store and track information regarding 
user defined transactions. 

! Terminal offline - Keep your store running even if your server is offline. 

! Additional reports ñ See your inventory and sales data in more detail. 

! Enhanced inventory transfers and PO’s ñ Streamline ordering and purchasing 
operations.  For example, you can receive items from orders using Quick 
Scan. 

And more...  

Advanced security features 
Store Operations incorporates tight security controls and restricts employee access to 
sensitive information. The Store Operations Manager program includes a built-in 
security system with 31 security levels (security definitions or profiles). 

As the administrator, you can set up each security level to grant certain access privileges. 
You can assign the behavior for every screen feature, defining what fields or command 
buttons can be viewed and/or edited by the employee. You can also disable entire menus 
and/or menu options. 

After you set up the security level, assign it to the appropriate employee(s). This way, 
you dictate precisely what information that employee can view and/or change in both the 
Manager and POS programs.  

New database technology 
Store Operations uses Microsoft SQL Server database technology for scalability and 
interoperability. SQL Server offers database size up to terabytes, provides reliable 
database access, and supports data warehousing and OLAP. It lets you install, deploy, 
and use the same database engine across platforms ranging from laptop computers 
running Windows 98 to large, multiprocessor servers running Windows 2000. 
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Store Operations works with Microsoft Database Engine (MSDE) or SQL Server. MSDE 
is a 100% SQL Server compatible data engine that runs on Windows 98 desktop 
computers to Windows NT/2000 servers. Databases created with MSDE are totally 
compatible with SQL Server and support many of the features of SQL Server. With 
MSDE, the database size is limited to 2GB maximum. For larger installations, SQL 
Server can be used instead of MSDE. SQL Server offers database size up to terabytes 
and supports multi-processors. 

Store Operations is fully scalable and can grow as your company grows. Because the 
software is based on Microsoft SQL Server, you can easily use Store Operations on 
stores with one checkout lane or hundreds of lanes.  

Internet applications 
Store Operations incorporates a Web-browser, Internet communications services, and 
XML support. As a web-enabled software system, Store Operations offers: 

! Management of virtual store fronts' inventory and sales orders from your brick-and-
mortar store 

! Support for future E-commerce and business-to-business commerce 

! E-Receipts (XML-based digital receipts) 

! Net display channels (broadcast websites and advertisements) 

! Custom POS buttons (on-screen shortcuts to websites, software packages and 
application tools) 

! Electronic access via the Internet to selected shipping carriers for automated 
shipping capabilities and services (i.e., partial shipping form completion)  

OPOS compatible 
Store Operations has incorporated OLE for Point of Sale (OPOS) standards, allowing 
you to select OPOS compatible hardware or peripherals to use with the software. Store 
Operations supports Windows printers and popular OPOS printers, scanners, scales, line 
displays, cash drawers, as well as interfaces to signature capture devices, MICR readers, 
and MSR. However, note that some printers may not be able to utilize all of Store 
Operations’s features (i.e., label graphics). By supporting OPOS, Store Operations 
makes it simple to interconnect POS hardware devices and lets you minimize software 
maintenance and upgrade costs.  
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Touchscreen Capabilities 
Store Operations offers customizable touchscreen features that give you key inventory, 
sales, and customer information literally at your fingertips. Use the Database menu's 
Keyboards option to customize the touchscreen keyboard and define the desired 
function keys, captions, and colors. You can customize the touchscreen keyboards to 
allow users to add item lookup by specific items, departments, categories, and/or 
suppliers. At the POS, press Ctrl-F6 to display and size the touchscreen keyboard. 

Net Display channels 
The Net Display lets you showcase advertisements and websites on another display 
monitor at your point-of-sale station. This monitor not only substitutes for the pole 
display by showing customer receipts in real-time, but it also rotates through pre-selected 
websites and Web pages as well as ads from your local CD-ROM or DVD. Use the Net 
Display Channels feature to: 

! Sell advertising time to other merchants and suppliers 

! Grab customers' attention 

! Show impulse items to waiting customers 

! Advertise upcoming specials, packages and kits 

! Form profitable partnerships  

Customizable Active Reports 

Store Operations adds valuable enhancements to its reporting capabilities. With point-
and-click speed, you can access key information easily and quickly. The software lets 
you generate a wide variety of consolidated reports to obtain instant sales figures, 
identify slow-moving items and see sales information for any day. On the report preview 
screen, customize each report to quickly find the specific information you need. 

Use Store Operations’s report options and tools to gather detailed item and sales data - 
data you can use to grow your business. After you generate the report, custom-build and 
organize your report directly on the report preview screen by: 

! Adjusting header and columns 

! Sorting and filtering report data 



 

 Store Operations Userís Guide      9 

! Refreshing report data 

! Accessing specific detailed information directly from the report 

Use the advanced sorting and filtering tools to fine-tune your reports and quickly 
pinpoint the exact data you need to realistically project future sales and make effective 
management decisions.  

Inventory Wizard 

In the Store Operations Manager program, you have your own personal automated 
assistant that will help you change properties in your database...all at once. Click 
Inventory Wizard on the Wizards menu to update item prices, costs, reorder 
information, sales tax assignment, or even put groups of selected items on promotion. 
The Inventory Wizard eliminates the need to manually change each individual item. It 
does most of the work for you and saves you an enormous amount of time.  

Receipts with logos and graphics 

Customize your point-of-sale receipts to display your company logo or graphics. 
Whether you want to promote your company name or highlight a special holiday sale, 
you can program the software to custom-build receipts that best relay your messages. 

The software can print graphics directly on the receipts, such as barcodes, logos, or 
pictures provided that your printer is capable of graphic printing. It can also include 
whatever text you want in your preferred font, format and style. You can then adjust the 
size and positioning of your graphics and text. 

At any time, use the Journal Viewer in either the Manager or POS program to view a 
graphical representation of each receipt. 

Label Designer and Label Wizard 

Store Operations introduces new features that speed up the way you process and use 
labels. The Label Designer lets you easily design your own label templates. In addition 
to adjusting label size and position, you can add a number of different label objects to the 
template, including text boxes and graphics. 

Whenever you print labels, use the Label Wizard to select one of your customized 
templates and specify the filter criteria. This way, you do not need to manually create 
and adjust labels every time you want to print a label.  
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Shipping and tracking via the Internet 
Store Operations offers automated shipping capabilities and services that enable you to 
use selected carriers' websites to complete shipping documents and track shipments. 
With an Internet connection, you can complete shipping documents using address and 
information in your sales orders, track shipments, and manage your account from the 
built-in browser screen.  

Customizable POS buttons (shortcuts) 
If you are using Store Operations with other software packages or tools, you can access 
them directly from your POS transaction screen. The Manager program includes a new 
menu option that lets you program command buttons on the POS that launch other 
software programs or access Web pages on your computer or via the Internet. POS 
buttons can trigger programs, invoke Web pages that can contain scripting code to access 
data on the current transaction, or pass information to external systems. 

These POS buttons normally appear on the right side of the point-of-sale transaction 
screen, but you can hide or position and size them as you choose. You can access up to 
ten programs, reference pages or websites and gain immediate access to worldwide 
computing power, without leaving the POS screen. 

For information on how to create a custom POS button, refer to the Customizing POS 
Buttons section. 

New Item Wizard 
Use the New Item Wizard to quickly add items to your database. The New Item Wizard 
enables you to set up the item type, define assembly and matrix components, as well as 
set the standard properties. 

This feature is especially useful for creating Assembly, Matrix, and Lot Matrix items. 
For example, rather than manually entering each component of a matrix item, use the 
New Item Wizard to automatically add components to the database at the same time.  

Retail price rounding 
Store Operations introduces a new global pricing feature that lets you perform retail 
price rounding. When you use the Inventory Wizard to change item prices, Store 
Operations includes an option that lets you round all updated prices to realistic retail 
values based on the rounding rules you specify. Assume, for example, you want to 
discount a certain category of items by 10%, but want the prices to be rounded up to the 
nearest dollar and end with the value $0.99. Store Operations provides the flexibility that 
enables you to do this type of retail rounding with ease.  
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Flexible tax structures 
You can assign tax based on the item or the customer. Assigning tax schedules on a per 
customer basis enables you to handle mail order. For example, you can charge different 
types of taxes based on particular cities or states. Use the Configuration option's Sales 
Tax tab to define your tax schedule. 

Extended inventory management 
The new inventory management features allow you to record and track the history of 
item quantity changes and shipments, store offline inventory, and generate receiving 
logs. For example, purchase orders and inventory transfers offer a History button that 
lets you view the item lookup code, date, and quantity received for each item shipment.  

Customizable POS screen 
Customize your point-of-sale transaction screen with the window displays you want. 
Press CTRL-F6 to pick and choose from a number of display features, including the 
status bar, HTML status bar, custom buttons, totals, function keys, and net display. You 
can also resize the window borders as well as adjust the size and position of the 
transaction screen. Store Operations saves the screen settings. 

Aged receivables feature 
The Aged Receivables feature offers a variety of flexible search and payment options. 
Process and track customer payments by individual invoices and statements at the point-
of-sale. Store Operations lets you select the specific invoice the customer wishes to pay. 
In addition to setting up revolving accounts, you can bill payments for net terms.  

Vouchers 
Store Operations handles different types of vouchers, including gift certificates and gift 
cards. You can sell and redeem vouchers any time. The gift card holder can spend any 
amount up to the card's limit, and the giver can renew the card repeatedly. Store 
Operations tallies cardholder purchases against a pre-purchased amount, and then 
recharges the gift card against a credit card, a store account or other tender.  

Detailed customer account information 
In addition to displaying every purchased item, Store Operations lists all of the 
customer's individual invoices, organizing them by original date, due date, reference 
number, transaction type, original total amount, and balance due. 
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In the Manager program, use the Account Information tab to look up detailed 
information for each invoice, make adjustments, and/or quickly print the applicable 
receipt. You have complete control over the customer account information and can 
adjust accounts as needed. You can also assign a specific cashier to a customer and 
prevent any other cashier from viewing the customer's account information and purchase 
history. 

Master pack quantity for ordering 
For ordering purposes, the new Master Pack Quantity (MPQ) feature enables you to 
define the bundle of items you want to order from a selected supplier. Store Operations 
uses this number for purchase orders. 

For example, if a supplier sold bike locks in sets of 10, you could enter the number "10" 
in the bike lock item's MPQ field. If you ordered this item, Store Operations 
automatically sets the quantity ordered to the next set of 10.  

Enhanced Journal Viewer 
Store Operations’s enhanced journal capabilities let you view and print any journal from 
any register in your preferred format. In either the Manager or POS program, you can 
quickly search for the desired journal or receipt. 

In the Store Operations Manager program, locate journals by going to the Journal menu 
and clicking View. You will see the Journal Viewer window, which offers various 
selection criteria you can use to pinpoint a specific journal. 

In the Store Operations POS program, you are not limited to searching for journals just 
at your own register. Instead, you can quickly view a variety of different receipts and 
report journals at whatever registers you choose.  

Unlimited line item entry 
Whether your customer wants to buy five items or five thousand items, you can ring up 
an unlimited number of items on your POS transaction screen. 
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Direct access to customer account details 
When you select a customer, you see detailed customer information directly on the 
transaction screen, including the billing and shipping address. You can also look up the 
customer's total sales, number of visits, and the last visit date in addition to the purchase 
history and detailed account information. This way, you have pertinent customer 
information literally at your fingertips. 

Built-In calendar 
The POS transaction screen includes a built-in calendar and automatic event reminder 
that help you track appointments and upcoming events. Specify the date, description, 
time of event, in addition to setting the event reminder and marking it as either a public 
or personal event. 

Sophisticated messaging capabilities 
The Message feature closely resembles your standard e-mail system, enabling you to 
track and manage messages. View the list of past messages and note the date and time 
they were sent.  

Improved orders, quotes, and layaways 
The POS program introduces new features that improve the way you create and process 
work orders, sales quotes, and layaways. 

View and edit detailed on-screen information - Press the function key assigned to the 
type of order you want to create and immediately see its detailed information at the top 
of your transaction screen. Depending on whether you process an order, quote, or 
layaway, this on-screen information can include the comment, on deposit amount, 
deposit payment, order balance, due date, reference number, and expiration date. Modify 
this information directly from the transaction screen by pressing SHIFT-F9. Store 
Operations displays a window with all the fields you can edit. 

Assign a reference number - Assign a reference number to your order, quote, or 
layaway. You can use this number for several purposes, including tying a sales 
transaction to a purchase order for use in inventory tracking. 

Accept and track payments - Rather than requiring customers to pay for all the items 
on the order, Store Operations lets them pay for any combination of the items at any 
time. After you recall a particular layaway, pick up a partial or the entire layaway.  
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Editable time clock entries 
View your employees' clock in/clock out times. On the Time Clock window, you will 
see all the cashier names and their associated time in, time out, and time elapsed (hrs) 
information. 

Edit the time card entries (clock in/clock out dates and times) directly in the Manager 
program by going to the Database menu and clicking Time Clock. This editing feature 
is especially useful whenever your cashiers log in under a different name or forget to 
clock in/clock out. 

You can also restrict the employee's access to time clock features.  

New assembly, matrix and lot matrix features 
Store Operations neatly organizes all of your assembly, matrix and lot matrix item 
information into a comprehensive grid. You can see your class items, the item 
components, and their related attributes (i.e. color, size, and style) all at once. The 
Attributes feature lets you quickly modify detailed item information for all the items 
contained in a particular class. This way, you do not have to manually look up each item 
and modify the information for only that specific item.  

Detailed graphs 
Store Operationsís graphs display key sales and inventory data. Press SHIFT-F6 and use 
the available drop-down list boxes to generate different graphs. 

Customize your own graph. For example, select different time periods and group certain 
data together. Store Operations displays the information in both a numerical and 
graphical format. This way, you can pinpoint the exact data you need.  

"Buy X, Get Y" discount capability 
Store Operations extends the sales and promotion features by incorporating the "Buy X, 
Get Y" discount capability. Sell a specified quantity ("X") of items at full price and give 
the customers a certain number ("Y") of items for free or at a discounted price. For 
example, if customers buy three T-shirts, they can receive another T-shirt for free. Or, if 
they buy four pairs of socks, they receive the next three pairs at a 50% off discount. Pick 
and choose the desired discount schedules.  
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Foreign currencies 
Store Operations lets you handle multiple foreign currencies and exchange rates. You 
can set up each desired currency with its associated exchange rate and locale. New 
features include the ability to assign specific currencies to certain suppliers for use in 
handling purchase orders and inventory transfers. Use Store Operations’s Label Designer 
to customize labels that display multiple exchange rates, even graphics of associated 
International flags.  

Reason codes 
You can customize reason codes to store and track information regarding user defined 
transactions (i.e., no sales, customer discounts, return of damaged merchandise, etc.) 
This data is stored for use in tracking and reporting. 

Terminal offline 
Store Operations enables you to keep your store running even if your file server is 
temporarily down or offline. For example, if the file server crashes during the business 
day and the cashier needs to continue with sales transactions, he can simply restart the 
POS program. If the terminal offline database is properly defined, Store Operations will 
switch to terminal offline mode and store standard sales transactions in a backup 
database. Once the file server has been restored, the cashier can restart the POS program, 
return to online mode and automatically update the primary database with the backup 
data.  

Additional reports 
In addition to offering more data columns for certain report lists, Store Operations adds 
additional reports, including the Pending Shipments report, Sales Tax Analysis report, 
Department Cost/Sales (Tax-Inclusive) report, and Tender Summary report. 

Enhanced ordering and purchasing 
Store Operations enhances purchasing and ordering operations by enabling users to 
receive items from orders using Quick Scan. Additional features include the ability to 
create PO's for items carried by selected primary suppliers. You can also select multiple 
suppliers and then order from only the primary or the lowest cost supplier. 
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Setting up your Store Operations database 

Key points 

! This section assumes you have successfully created your Store Operations database 
using Store Operations Administrator. Refer to the Deployment Guide in Store 
Operations Administrator Online Help for more information. 

! This section will show you how to set up your database with the basic inventory, 
tax, cashier, payment type, and register information. 

! If you imported an existing QuickSell 2000 database or are using a sample database, 
you do not need to set up the database from scratch. Just use the Manager program 
to modify the existing database information as needed. 

! If you have never used the Store Operations software, you need to set up the 
database from scratch. To do this, collect basic information about your store (i.e., 
items, taxes, registers, cashiers, etc.) and enter all the data into the Store Operations 
database. 

! Setting up your database for the first time is probably the most time-consuming part 
of using the software. However, after you set up your database, you will find that 
using Store Operations is very quick, easy and efficient. For step-by-step 
instructions on how to enter this information, refer to the Collecting Basic 
Information topic.  
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Collecting basic information 

Your Store Operations database should contain all the items in your store. The following 
material represents a recommended course of actions. It does not represent the only way 
to set up your database; however Microsoft's years of experience combined with 
customer feedback have contributed to formulating this sequence of steps. 

Step 1: Set basic store-wide parameters 

1. On the File menu, click Configuration to set up the basic store-wide parameters. 
Include all pertinent store information, such as the store name, address, phone 
number, layaway and store account policies, inventory methods, etc. 

2. Use the Store tab to enter your store name and address information. 

3. If you allow layaways, work orders, back orders, and/or quotes, enter the applicable 
expiration limit, minimum deposit, and due date information on the Ordering tab. 

4. Store Operations will update the cost of received items and calculate the price based 
on the information entered on the Inventory tab. 

5. In the Customer Fields tab, enter any additional information you may wish to track. 

6. Review the list of options provided on the Options tab and select the ones that 
match your store policies and operating procedures. Keep in mind that the selected 
options will affect all POS registers in the store. 

7. Store Operations will use the information entered on the Accounts tab to process 
customer statements and assign the default account type. Tip: Before you use this 
tab, use the Account Types option in the Database menu to set up all the applicable 
account types. 

8. Use the Sales Tax tab to select the sales tax method and tax schedule basis. 
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Step 2: Define departments and categories 

Although it is not required, we suggest using the Departments & Categories option in 
the Database menu to group inventory items into departments and categories. This way, 
you can use Store Operations’s extensive reporting features to monitor activities in the 
various sections of the store, to review each department's contribution to the overall 
profit, and to adjust pricing based on departmental grouping. 

Step 3: Enter suppliers information 

Use the Suppliers option in the Database menu to enter supplier information. Although 
you can do this at any time, it is a good idea to enter the supplier information prior to 
entering item information. This way, the item record contains fields for supplier 
information. 

Tip: If your business will accept different foreign currencies, use the Currencies menu 
option to set up all your currencies and exchange rates before you enter the suppliers. 

Step 4: Define sales tax 

Located in the Database menu, the Sales Taxes option allows flexible schemes for 
computing sales taxes. Each item in inventory may be associated with an item tax. The 
item tax is computed based on one or more sales tax tables. This scheme allows Store 
Operations to apply the correct tax in even the most demanding retail environments. 
Because the item tax requires sales tax tables to be defined, perform this step prior to 
defining the item tax. 

Step 5: Define item tax 

Use the Item Taxes (or Customer Taxes) option in the Database menu to gather and 
sort all tax breaks (sales taxes) defined in the previous step into separate tax codes. The 
tax codes created during this step are the tax definitions that are actually applied to an 
item. Note: If you used the Sales Tax tab in the Configuration option to assign tax 
schedules on a per customer basis (used mainly for mail order), Store Operations 
automatically changes the Items Taxes option to the Customer Taxes option. 
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Step 6: Set up pole display messages 

If a pole display is connected to a POS station, use the Pole Display Messages option in 
the Database menu to configure different messages to display. The selected message 
will continually display whenever a sale is not in progress and the register is idle. 

Step 7: Enter receipt format information 

The Receipt Formats option in the Database menu allows you to customize the 
information that will print in the header of receipts. Using multiple configurations, you 
can apply different header types. You can also choose (and preview) receipt template-
styles for each transaction type. 

Step 8: Set up POS register configuration 

The Database menu's Registers option informs Store Operations what types of POS 
equipment are installed at each register. By using the tab method of configuration, you 
can easily change the parameter of any register terminal to reflect its current 
configuration. 

Step 9: Enter tender types 

You can probably anticipate what types of tender your customers are likely to present 
and what types you want to accept. By using the Tender Types option in the Database 
menu to set up the various types, such as cash, checks, credit cards, vouchers, etc., you 
facilitate how the cashier will conduct each transaction at the point-of-sale. 

Tip: If your business will accept different foreign currencies, use the Currencies menu 
option to set up all your currencies and exchange rates before you enter the tender types. 



 

20      Store Operations Userís Guide  

Step 10: Set up cashiers 

The Cashiers option in the Database menu enables you to specify exactly what rights 
and limitations each cashier has. For example, a "head" cashier may be allowed to open 
the cash drawer when there is no transaction in progress. If you plan to use Store 
Operations’s advanced security system, it is a good idea to set up the security levels and 
then assign them to the applicable cashiers. For instructions, refer to the Setting Up 
Security Structure section. 

Note: In order create, modify and/or delete cashiers, you must have Administrator 
Rights. The very first time you log onto the Manager program, you are given 
Administrator Rights. You would then create your cashiers and assign them with the 
applicable access privileges. 

Step 11: Define item messages 

Using the Item Messages option in the Database menu, you can display a certain 
message whenever a desired item is selected for purchase at the register terminal. Use 
this option to remind the cashier of important information regarding an item, such as to 
check for a minimum age requirement. 

Step 12: Enter each item 

When you use the Items option in the Database menu to enter items to the Store 
Operations database, you should include the pertinent details for each item in the store. 
This item information is readily accessible, virtually at the cashier's fingertips, at the 
point-of-sale. You can also use the New Item Wizard to quickly enter items into the 
database. 

Tip: If you install more than one POS station, configure each one prior to entering the 
items. This way you can use more than one register to enter the item information at the 
same time, whereby reducing the time needed to enter all the items into the database. If 
a barcode scanner is present, use it to scan the item lookup code into the database. This 
way, no numbers will be missed. 
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Step 13: Define shipping carriers 

If your store allows shipping, you can use the Shipping Carriers option in the Database 
menu to set up the applicable shipping carriers (i.e. FedEx, UPS) and services (2nd Day 
Air). You can then go to the File menu, click Configuration, and then click the 
Shipping tab to define the default shipping carrier and service. 

Step 14: Create account types 

If your store allows customer charge accounts, use the Account Types option in the 
Database menu to set up the applicable accounts (i.e. Revolving Charge Account). You 
can then go to the File menu, click Configuration, and then click the Accounts tab to 
define the default account type for new customers. By setting up the account types 
before you enter customer information, you save valuable time and effort. 

Step 15: Enter customer accounts 

Use the Customers menu option in the Database menu to create customer accounts. Set 
up the customers' billing information, shipping address, options, etc. so that this 
information will be available to the cashiers at the point-of-sale. 

After you enter all your inventory and/or customer account information, define all the 
additional Store Operations features your store will use, such as Custom POS Buttons, 
Net Display Channels, etc.  
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Manager program 

Overview 

The Store Operations Manager program acts as your own personal administrative 
assistant. As you navigate through the Manager, use the software's built-in functions to 
perform all of your back-office activities. These include the following: 

! Setting up security structure - Set up security levels to grant certain access 
privileges for both the Manager and POS programs. 

! Managing your database - Enter and modify the data (i.e., items, suppliers, register 
information) that keeps the store running smoothly. 

! Controlling pricing - Change item prices and costs, in addition to defining level 
pricing and price limits. 

! Tracking inventory - Handle all aspects of the inventory, including receiving 
inventory and working with purchase orders and inventory transfer orders. 

! Tracking sales - Track the goods and services you sell to your customers. 

! Managing customers - Create and maintain your customer database. 

! Shipping and tracking - Run mail order houses from the same store inventory. 

! Managing employees - Manage cashier and sales rep data, including security 
controls, access privileges, cashier attendance and sales commissions. 

! Generating reports - View and print countless reports. Customize the report 
directly on the print preview screen. 

! Using labels - Design your own label templates and then use the Label Wizard to 
specify filter criteria. 

! Processing receipts and journals - Work with register log activity reports. Options 
include the ability to view journals, create receipt formats and assign them to 
registers, and post closed journals to external accounting programs. 
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Navigating through Manager 

The main Manager window 

After you log onto Store Operations Manager, the main user interface greets you. 

 
 
Menu bar 

The Menu bar appears directly below the title bar (Store Operations Manager) and 
contains a number of menus from which you select commands to perform tasks. 

The available menus will be consistent throughout Store Operations. Either clicking the 
menu name with the pointing device (i.e. mouse) or using a keyboard equivalent may 
open a menu. 

To open a menu using the keyboard, hold down the ALT key and type the underlined 
character. To close an open menu, click any area outside the menu or press the ESC key. 
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Toolbar 
The Store Operations toolbar is located directly beneath the Menu bar. Each toolbar 
button is a shortcut for a commonly performed task. To rearrange the toolbar, click-and-
drag the toolbar to the desired position. The following describes each button. 

Button: Purpose: 

 Set up and configure the Store Operations database. 

 Define security levels to grant employees certain access privileges. 

 
Edit item attribute information, such as barcode, price, profit margins, etc. 

 Create, edit, and maintain your suppliers' account information. 

 View and edit customer accounts. 

 Automatically update item prices, costs, reorder information, sales tax 
assignment, and put groups of selected items on promotion. 

 Generate purchase orders and receive items into your database. 

 Add items to your database without using a purchase order. 

 Remove items from your inventory and record the process. This function is 
used mainly for multi-store operations. 

 Print labels for selected items using a particular label style. 

 Locate and view any journal from any register in your preferred format. 

Getting Started Task Pad 
The Getting Started Task Pad appears directly below the toolbar in the main work area. 
The Task Pad contains additional shortcuts for frequently performed tasks: Inventory, 
Items, Journal, Reports, Wizards, and Help. For example, click Inventory to display 
commands for Transfer Inventory In, Transfer Inventory Out, New Purchase Order, and 
Edit Purchase Order. 

Navigating tools  
Store Operations gives you the flexibility to change and organize your on-screen data. 

Store Operations dialog boxes and tabs 
Store Operations presents its information (i.e., item properties, store properties) in dialog 
boxes (windows). Field boxes that are shaded gray cannot be edited. 

Similar to file folder labels, tabs separate sections of the dialog box into logical groups. 
To access a tab, simply click its name. With the keyboard, select a tab by pressing the 
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ALT key and the underlined character in the tab's name. 

Resizing and sorting columns 
Columns displayed in Store Operations are normally resizable. To resize a column, place 
the mouse pointer on the vertical line. Once the mouse cursor changes to an arrow, click-
and-drag the mouse in either direction and release the mouse button when the column is 
at the appropriate size. 

Most of the time, you can sort the columns of data displayed in the Store Operations list 
boxes. In order to sort entries in a column, click on its heading. Repeatedly clicking on a 
header will toggle between ascending and descending sorting.  

Using the mouse  
When you use a Windows-based program like Store Operations Manager, you will find 
that using the mouse is the most efficient way to work. For example, use the mouse for 
Active Reports and the Inventory Wizard Workpad. You can also use your mouse to 
enlarge or reduce (zoom in/out) the print preview for journals and receipts. 

On the applicable window, right-click your mouse and choose from a short list of 
commands. The available commands vary depending on the window that is displayed. 

Term: Description: 
Copy Duplicates the selected text. 
Copy as 
Table 

Copies all entries in the list to the clipboard. You can then paste that data 
into any standard Windows-based program. 

Paste  Inserts the copied data from the clipboard. 
Paste to All 
Rows 

Pastes the data on your clipboard to all the rows in a single column. Place 
your cursor on a field in the column whose rows you want to update with the 
new price. Right-click your mouse and select Paste to All Rows. Store 
Operations will paste the data to all the rows in the column. This allows all 
the items to share the same price. By using this feature, you save time. 

Formula Performs mark-ups, mark-downs, and bulk changes to an entire column. 
You can assign a mathematical formula to either a single row or all the 
rows. For example, when you use the Inventory Wizard to apply prices 
changes to a number of items, you can create a formula that will set the 
price equal to cost + 10%. 

Hide/Unhide 
Columns 

Removes or displays the selected columns. This command is especially 
useful for reports. 

Insert Row Adds an entry. 
Delete Row Removes the entry you inserted. 
Import Takes information from a text file and puts it into the database. 
Export Exports information to a text file for use in other applications. 
Print Sends the selected information or window to the designated printer. 
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Setting up security structure 

You can protect every field on any Manager or POS display based on the cashier's 
security level. The Set Security option in the File menu enables you to switch to 
Security mode. In this mode, you can define data fields as 'hidden', 'view-only', or 
'editable'. This way, you define exactly what control(s) the cashier can view and/or edit.  

You can also set security for entire menus (i.e., Wizards) and/or menu options (i.e., 
Label Wizard) in the Manager program. 

Note: The standard shipment has all the commands and functions enabled. When you 
receive the software, you need to build your security structure and set up each level. To 
set up the security structure, you must have Administrator Rights. 

Read the following to learn how to: 

! Set up a security level 

! Assign the security level to the employee(s) 
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Setting up a security level 

As the administrator, use the following guidelines to set up your security levels for the 
Manager program. If desired, set up the levels for the POS program. 

After you define the security levels, you can assign them to your employees. 

To set up a security level in the Manager program 

1. On the File menu, click Security, and then click Set Security. 

2. The Security Mode window informs you that the system is now in security mode. 
Click OK. You will see the Security Mode icon on the bottom of your screen. 

3. There are two slightly different ways to define security. 

- To set the security for an entire menu (i.e., Journals) or menu option (i.e., Close 
Billing Cycle), press CTRL-ALT-S. After Store Operations informs you that the 
system is now in the menu security mode, click OK. Select the desired menu or 
menu option, and then right-click your mouse to define the security behavior. 
Note that after you press CTRL-ALT-S, left-clicking your mouse does not let 
you drill down to specific windows. When you right-click your mouse, you can 
disable the menu or menu option for the applicable security levels. When you 
disable a menu option (i.e., Customers), its associated button on the main 
interface's toolbar will automatically be disabled. Repeatedly pressing CTRL-
ALT-S enables you to toggle the menu security mode. 

- To set security behaviors for individual field boxes and controls, refer to the 
following guidelines. Note: First ensure that the menu names are not 
highlighted in blue. If they are, press CTRL-ALT-S to exit from menu security 
mode. 

4. Select a window whose security controls you want to define. For this example, go to 
the Database menu, click Items, and then click Item Messages. 

5. Press CTRL-S. Each control will be highlighted in either a blue (control currently as 
no access restrictions) or red (control currently has some type of access restriction) 
color. If you move the cursor over the controls, Store Operations highlights the 
selected control in yellow. 
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6. If you do not want certain employees to be able to remove an item message from the 
database, you could restrict access to the Delete button. To do this, click on the 
Delete button. You will see the Security window. 

7. In the Access Rights table, position the cursor on the applicable security level and 
either select or clear the Disable Change option for the applicable security level. If 
you select (check) the option, the cashier assigned to this security level will not be 
able to delete an item message. In security mode, this option will be highlighted in 
red showing you that the control has some type of restriction. 

8. Click OK. 

9. On the Item Messages window, continue to set the security access for the applicable 
controls. 

10. When you finish, press CTRL-S. You can then display another window and press 
CTRL-S again to assign the security access privileges. Repeatedly pressing CTRL-S 
enables you to switch from assigning security control behaviors to displaying other 
windows. 

11. After you set up your security structure, you can exit security mode by clicking Set 
Security again and then clicking OK on the Security Mode window. 

To set up a security level in the POS program 

1. On the transaction screen, click on the blank field located to the left of the F7: Set 
Customer function key. You should see the Security Mode icon displayed both on 
the field that was just clicked and at the top of the transaction screen. 

2. Select the window whose security controls you want to define. For this example, 
press F2 to display the Items window. 

3. Press CTRL-S. Each control will be highlighted in either a blue (control currently as 
no access restrictions) or red (control currently has some type of access restriction) 
color. If you move the cursor over the controls, Store Operations highlights the 
selected control in yellow. 

4. If you do not want certain cashiers to be able to delete an item at the point-of-sale, 
you could restrict access to the Delete button. To do this, click on the Delete button. 
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You will see the Security window. 

5. In the Access Rights table, position the cursor on the applicable security level and 
either select or clear the Disable Change option for the applicable security level. If 
you select (check) the option, the cashier assigned to this security level will not be 
able to delete an item. 

6. Click OK. 

7. On the Items window, you can set the security access for the applicable controls. 

8. When you finish, press CTRL-S. You can then display another window and press 
CTRL-S again to assign the security access privileges. Repeatedly pressing CTRL-S 
enables you to switch from assigning security control behaviors to displaying other 
windows. 

9. After you set up your security structure, click on the Security Mode icon located on 
the bottom left corner of the transaction screen to exit security mode.  

Assigning security level to employee 

After you set up your security level(s), you can then assign it to the appropriate 
employee(s). 

To assign a security level to your employee 

1. On the Database menu, click Cashiers. 

2. Select a cashier from the Cashiers list, and then click Properties. The Cashier 
Properties window appears and displays the selected cashier's security information. 

3. In the Security Level drop-down list box, select the appropriate level number. 

4. Click OK.  
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Working with your database 

The key to successfully managing your inventory is to maintain an up-to-date 
comprehensive database. As you adjust your inventory, you should continually update 
your database.  

Read the following sections and learn how to: 

! Add and delete items 

! Create item assemblies, matrices, and lot matrices 

! Handle kit and serialized items 

! Use gift vouchers 

! Edit departments and categories, sales taxes, item taxes, and tender types 

! Use aliases and substitutes 

! Manage supplier information 

! Set up exchange currencies, POS buttons, reason codes and net display channels 
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Adding new items 

Whenever you receive new inventory items, you should enter all of the item properties 
into the Store Operations database. This way, you can easily change the item's barcodes, 
prices, or other information. You can either manually add items to your database or use 
the New Item Wizard. 

The New Item Wizard is especially useful when you are creating Assembly, Matrix, 
and/or Lot Matrix items. For example, rather than manually entering each component of 
a matrix item, you can use the New Item Wizard to automatically create the components 
all at once. 

To create a new item 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Click New. You can also click Copy to copy values from an existing record. 

3. Use the various tabs in the Item Properties window to enter all the item's properties 
(i.e., item lookup code, description, quantity, pricing). 

4. When you finish entering all the item information, click OK to save the information. 

To add a standard item using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. 

3. Use the Item Type drop-down list box to select 'Standard'. 

4. Using the available fields, enter the item's lookup code, description, quantity, price, 
cost, department, category, supplier, item tax, barcode, and bin location, and then 
click Next. 

5. To add this item to the database, click Finish. 

Note: If you assigned the item a type other than "Standard," the guidelines and 
windows may vary.  
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Deleting existing items 

Generally, you should not delete items after they are associated with sales transactions. 

Note: Deleting items has serious implications and will invalidate data associated with 
the items. You should be fully aware of its consequences. 

To delete an item 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Select the item you want to remove, and then click Delete. Store Operations 
displays a reminder that deleting the selected item can not be undone. 

3. To delete the item, click Yes. To cancel and return to the Items window, click No.  
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Using item assemblies 

You can organize all your assembly items in the Store Operations database. There are 
two ways to create them. Use the Item Assemblies menu option to create and edit an 
assembly item. Or, use the New Item Wizard, which eliminates a step and allows you to 
quickly enter the assembly item's components and quantities. 

To define an assembly item 

1. On the Database menu, click Items, and then click Item Assemblies. The Item 
Assemblies window appears. 

2. Click New. 

3. On the Item Assembly Properties window, enter the Assembly Lookup Code and 
Description. 

4. To define the assembly's component prices, select the Use component price option. 
This option enables you to enter a price that differs from the standard item price in 
the database. For example, you may want to discount the prices for the components 
if the customer buys the entire assembly. 

5. To add a component to this assembly item, click Add. 

6. On the Items window, select the applicable item and then click OK. You will see 
that item in the Components table. 

7. Use the Name, Quantity, and/or Price fields to define the title of the item 
component, specify how many of that particular item are included in the assembly, 
and/or define the price. 

8. Continue to add all the applicable item components. 

9. When you finish entering all the information for the assembly item, click OK. 
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To define an assembly using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. 

3. Using the available fields, define the Item Type as 'Assembly' and then enter the 
item lookup code, description, and other applicable information, such as quantity, 
price, cost, department, category, supplier, item tax, barcode and bin location. 

4. Click Next to add the assembly's components. 

5. In the Component Name field, enter the description of the assembly component 
and then enter the applicable quantity in the Quantity field. When you finish 
entering the components, click Next to continue. 

6. In the Components table, enter the applicable description, price and quantity for 
each assembly component. You can also modify the item lookup code(s). 

7. Click Next to continue. 

8. On the final wizard window, click Finish to add the item to the database. You can 
also click Cancel to cancel the operation. 

When you go to the Database menu and click Item Assemblies, you should see the new 
item in the Item Assemblies window. Click Properties to modify this item's information. 
On the Properties window, you can click Attributes to view and/or modify the attribute 
information for selected individual components.  
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Using item matrices 

There are two ways to create a matrix item. Use the Item Matrices menu option to create 
and edit the matrix item. You can also use the New Item Wizard, which eliminates a step 
and allows you to enter the matrix item and all of its individual components at the same 
time. It leads you through a few simple screens to define the matrix item's general 
properties (i.e., item lookup code, description, price, cost), as well as the matrix 
dimensions and quantities. 

To define a matrix item 

1. On the Database menu, click Items, and then click Item Matrices. The Item 
Matrices window appears. 

2. Click New. 

3. On the Item Matrix Properties window, enter the Matrix Lookup Code and 
Description. 

4. Using the Dimensions drop-down list, select the number of dimensions you want to 
define. 

5. In the applicable Dimension fields, enter the name of the dimension (i.e., size, 
color, style). 

6. To add a component to this matrix item, click Add. 

7. On the Items window, select the applicable item and then click OK. You will see 
that item in the Components table. 

8. In the Heading fields, enter the applicable headings (i.e. Small, Blue) for the item. 
The number of available headings depends on the number of dimensions selected. 

9. Continue to add all the applicable item components. 

10. When you finish entering all the matrix information, click OK to save the 
information. 
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To define a matrix using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. 

3. Using the available fields, define the Item Type as "Matrix" and then enter the item 
lookup code, description, and other applicable information, such as quantity, price, 
cost, department, category, supplier, item tax, and bin location. 

4. Click Next to create the matrix dimensions. 

5. In the Title field(s), enter the applicable matrix titles (i.e., size, color, style). 

6. For each title, define the applicable fields (i.e., small, medium, blue, white, etc). 

7. Select or clear the 'Include matrix fields in each description' option. 

8. Click Next to continue. 

9. In the Components table, enter/modify the applicable item lookup code, 
description, price and quantity for each matrix component. You can also define 
which components you want to include within the matrix item class. 

10. Click Next to continue. 

11. On the final wizard window, click Finish to add the item to the database. You can 
also click Cancel to cancel the operation. 

When you go to the Database menu and click Item Matrices, you should see the new 
item listed in the Item Matrices window. Click Properties to modify this item's 
information. On the Properties window, click Attributes to view and/or modify the 
attribute information for selected individual components.  
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Using item lot matrices 

You can organize and track your lot matrix items. There are two ways you can create a 
lot matrix item. Use the Lot Matrices menu option, or use the New Item Wizard, which 
quickly adds the lot matrix item and all its individual components at the same time. The 
following guidelines show how to define a lot matrix item and its associated components 
in the Store Operations database. 

To define a lot matrix item 

1. On the Database menu, click Items, and then click Item Lot Matrices. 

2. Click New. 

3. On the Item Lot Matrices Properties window, enter the Lot Matrix Lookup Code 
and Description (i.e., Beverage, Cola). 

4. To add a component, click Add. 

5. On the Items window, select the applicable item and then click OK. You will see 
that item in the Components table. 

6. In the Name box, enter the name of the item component (i.e., six pack). 

7. Continue to add all the applicable item components. 

8. When you finish entering all the lot matrix information, click OK. 

To define a lot matrix using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. Using the available fields, define the Item 
Type as 'Lot Matrix' and then enter the item lookup code, description, and other 
applicable information, such as quantity, price, cost, department, category, supplier, 
item tax, and bin location. 
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3. Click Next. 

4. On the Lot Matrix Properties grid, define the applicable elements (i.e., title, lot 
price, and lot quantity). 

5. Click Next. 

6. On the Components grid, enter/modify the item lookup code, description, price 
and/or quantity for each component, and then click Next. You can also select which 
components you want to include within the lot matrix item. 

7. To add these items and their quantities to the database, click Finish. To modify the 
information, click Back. To cancel the process, click Cancel. 

8. When you click Finish, Store Operations displays a window confirming that you are 
creating an item. To proceed, click Yes. 

9. Store Operations will display a window to inform you that you have successfully 
added the item to your database. Click OK. 

When you go to the Database menu and click Item Lot Matrices, you should see the new 
item listed in the Item Lot Matrices window. Click Properties to modify this item's 
information. On the Properties window, click Attributes to view and/or modify the 
attribute information for selected individual components.  
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Handling kit items 

A kit item (i.e., First Aid Kit) is an item file that contains other items found in the 
database to be sold as one item. When you sell a kit item, the individual kit components 
will not increment or decrement; it is only the kit item itself that will. There are a couple 
ways to define a kit item. You can use either the Items menu option or the New Item 
Wizard. The New Item Wizard enables you to add the kit item and all its components at 
the same time. 

To create a kit item using the Items menu option 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Click New to display the Item Properties window. 

3. On the General tab, enter the Item Lookup Code. 

4. Using the Item Type drop-down list box, select 'Kit'. 

5. Enter the applicable item information (i.e., description, barcode). 

6. Click the Kit tab. 

7. To select a component in the kit, click Add. 

8. Select the applicable item component, and then click OK. 

9. Enter the applicable quantity in the Quantity box. 

10. When you finish defining all the kit components, use the other available tabs to 
enter the appropriate property information. 

11. Click OK to save the information. 
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To create a kit item using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. Using the available fields, define the Item 
Type as 'Kit' and then enter the item lookup code, description, and other applicable 
information, such as quantity, price, cost, department, category, supplier, item tax, 
and bin location. 

3. Click Next to add the kit's components. 

4. In the Component Name box, enter the description of the kit properties and then 
enter the applicable kit quantity. Click Next to continue. 

5. In the Components table, enter/modify the applicable item lookup code, 
description, price and quantity for each kit component. 

6. Click Next to continue. 

7. On the final wizard window, click Finish to add the item to the database. You can 
also click Cancel to cancel the operation.  
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Handling serialized items 

A serial number is a unique code that identifies individual units for an inventory item. 
You can assign up to three serial numbers for an item. 

For example, a digital cellular phone may have a serial number for the phone, a number 
for the SIM identification card, and a telephone number. Store Operations can track and 
maintain these serial numbers. The first serial number is the primary serial number and 
should be unique. The second or third numbers are supplemental numbers. 

You can create a serialized item using either the Items menu option or the New Item 
Wizard. 

To create a serialized item 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Click New. 

3. On the Item Properties window, click the General tab and enter all the item attribute 
information. 

4. Using the Item Type drop-down list box, select Serialized. 

5. Click the Serial tab. 

6. Select the correct Serial Number Count (one, two, or three serial numbers), and 
then click Add. 

7. On the Serial Number Properties window, enter the serial number(s), and then click 
OK. 

Tip: To quickly add multiple serial numbers all at once, select the Range option, 
enter the desired serial prefix, and then, in the Count box, enter the number of serial 
numbers you are creating. You can also specify in the Starting From box the 
beginning number from which Store Operations will use to generate the proceeding 
numbers. 

8. When you finish entering all the serial numbers, use the other available tabs to enter 
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all the appropriate property information. 

9. Click OK to save the information. 

Note: To automatically update the item's Quantity field every time a serial number is 
added, confirm that the 'Synchronize quantity with serial numbers' option is selected 
on the Options tab. To select this option, go to the File menu, click Configuration, click 
the Options tab, and then select (check) the option. 

To create a serialized item using the New Item Wizard 

1. On the Wizards menu, click New Item Wizard. 

2. Click Next to define the item's properties. Using the available fields, define the Item 
Type as 'Serialized' and then enter the item lookup code, description, and other 
applicable information, such as quantity, price, cost, department, category, supplier, 
item tax, and bin location. 

3. Click Next to continue. 

4. On the final wizard window, click Finish to add the item to the database. You can 
also click Cancel to cancel the operation. 

5. Because you are creating a serialized item, you need to assign the serial numbers. 
On the Database menu, click Items. 

6. Select the item you just created, and then click Properties. 

7. Click the Serial tab. 

8. Select the Serial Number Count. 

9. Use the Add button to add the serial numbers to the Serial table. 

10. Click OK to save the information.  
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Using vouchers 

Vouchers can include gift certificates and gift cards. A gift card acts like a debit card. 
Customers can pre-pay a certain amount towards the gift card. The next time a customer 
uses the gift card, the sales transaction amount is deducted from the gift card. 

Customers can purchase vouchers and redeem them. The voucher holder can spend any 
amount up to the voucher's limit, and the giver can renew the card repeatedly. Store 
Operations tallies cardholder purchases against a pre-purchased amount, and then 
recharges the voucher against a credit card, a store account or other tender. Store 
Operations prints receipts that document every purchase. 

Before you can use vouchers at the point-of-sale, you need to create both the voucher 
item and the voucher tender type. This way, you can both sell and redeem vouchers at the 
point-of-sale. In case a customer loses a particular voucher, the cashier can also transfer 
credit from the existing voucher to a new voucher. 

Note: To define the expiration period for vouchers, go to the Configuration option in 
the File menu, click the Tender tab, and then enter the number of days the customer has 
until the voucher expires. 

To create a voucher item 

1. Open the Manager program. 

2. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

3. Click New. 

4. On the General tab, enter the Item Lookup Code and Description (e.g., "Gift 
Card"). 

5. In the Item Type box, select Voucher. 

6. Click the Serial tab. Use this tab to enter the voucher ID (serial) numbers. 

7. Click Add. The Serial Number Properties window appears. 

Tip: To quickly add multiple serial numbers all at once, select the Range option, 
enter the desired serial prefix, and then, in the Count box, enter the number of serial 
numbers you are creating. You can also specify in the Starting From box the 
beginning number from which Store Operations will use to generate the proceeding 
numbers. 



 

44      Store Operations Userís Guide  

8. Enter the applicable voucher numbers, and then click OK. 

9. Click the Pricing tab. 

10. If you are selling vouchers that have pre-defined amounts ($25.00, $50.00), you can 
enter the applicable amount in the Price field. Note: You must create a new voucher 
item for each pre-defined amount. 

If you are not selling vouchers with pre-defined amounts and want to enter the 
applicable amount at the point-of-sale, set the Price to $0.00. Also, select the 'Must 
enter price at the POS' option in the Items menu's Options tab. Store Operations 
will then require the cashier to enter a price for each voucher sold. 

11. Click the Inventory tab, and either confirm or modify the quantity you have in 
stock. 

12. Click OK. 

If you want customers to redeem the voucher, you must create a Voucher tender type. 

To create a voucher tender type 

1. On the Database menu, click Tender Types. The Tender Types window appears. 

2. Click New. 

3. In the Description box, enter the name by which the tender type can be referenced 
(i.e., Gift Card). 

4. In the Tender type box, select Voucher. 

5. In the Tender code box, enter the applicable code (i.e. GC). 

6. Click OK. 

You can now sell and redeem vouchers at the point-of-sale.  
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Editing departments and categories 

Store Operations enables you to organize your inventory into departments and 
categories, which will facilitate cleaner report output. You can modify your departments 
and categories on one window and see all your data right in front of you. 

To add a department/category 

1. On the Database menu, click Departments & Categories. 

2. To add a department, click the New button under the Departments heading. To add 
a category, select the applicable department and then click the New button under the 
Categories heading. 

3. On the Properties window, enter the appropriate information, including name and 
code. If you are adding a category, select the applicable Department. 

4. Click OK. 

To modify a department/category 

1. On the Database menu, click Departments & Categories. 

2. Select the department or category whose information you would like to edit, and 
click Properties (or press Enter). 

3. On the Properties window, edit the appropriate information. 

4. Click OK.  
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Editing sales tax 

You can define sales tax codes and enter details regarding any sales taxes you want to 
apply at your store. After you create the sales taxes, you can then assign the appropriate 
sales tax to each item tax. You can also use the Inventory Wizard to automatically assign 
the sales taxes to selected items. 

To add a new sales tax definition 

1. On the Database menu, click Sales Taxes. The Sales Taxes window appears. 

2. Click New to create a new sales tax, or select an existing entry and click Copy to 
create a new entry similar to the existing one. 

3. On the Sales Tax Properties window, enter the properties (i.e. description, code, 
maximum taxable amount, sales tax rate, etc.), and then click OK. 

Note: Once you create the sales tax definitions, you need to add or modify the item tax 
definition that will use the new sales tax. 

To remove an existing sales tax definition 

1. On the Database menu, click Sales Taxes. You will see a list of all your existing 
sales taxes. 

2. Select the entry to delete, and click Delete. 

3. Then modify, as applicable, the item tax definition that used the sales tax. 

To modify sales tax properties 

1. On the Database menu, click Sales Taxes. You will see a list of your existing sales 
taxes. 

2. Select the entry you wish to modify, and then click Properties. 

3. Change the item properties, and then click OK. 

4. Then modify, as applicable, the item tax definition that used the sales tax. 

Whenever you want a quick and easy way to assign the sales tax to selected items, use 
the Inventory Wizard. 
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To assign sales tax to multiple items 

1. On the Wizards menu, click Inventory Wizard. The Inventory Wizard appears. 

2. Click Next to display the 'Select the Task to Perform' window. 

3. Using the drop-down list box, click Task 170: Assign Item Sales Tax. Then click 
Next. 

4. Select the items whose sales tax you want to assign. Click Next. 

5. If you do not want to change any of the information, click Finish to display the 
Inventory Wizard Workpad. 

6. If all the information is correct, click Commit to apply the changes to your 
database. To cancel the changes, click Cancel.  

Editing item tax 

When you initially set up your database, you should define the tax that will be applied to 
each item. You can add, modify, or delete an item tax at any time. 

Note: If you used the Sales Tax tab in the Configuration menu option to select the 
Assign tax schedules on a per customer basis option, Store Operations automatically 
changes the Item Taxes menu option to the Customer Taxes option. The guidelines for 
each are very similar. 

To add a new tax 

1. On the Database menu, click Item Taxes. The Item Taxes window appears. 

2. Click New. 

3. Enter the description and code by which the Item Tax is referenced. 

4. Using the Sales Tax Selection drop-down list boxes, select the applicable sales tax. 

5. Select or clear the Compute tax on {Price - Cost} instead of Price option. 
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6. Click OK. 

To edit an existing item tax 

1. On the Database menu, click Item Taxes. 

2. On the Item Taxes window, select the appropriate item tax, and then click 
Properties. 

3. Modify the properties as desired, and then click OK. 

 Note: For this change to take effect, you must Z-out and restart each POS station. 

To delete an item tax 

1. On the Database menu, click Item Taxes. 

2. On the Item Taxes window, select the item tax you want to remove, and then click 
Delete. 

3. When you see a window reminding you that you have selected a record for deletion, 
answer appropriately.  
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Editing tender types 

You can continually modify the types of tender (i.e., cash, check, credit card) that you 
will accept at your store. Some tender types include additional settings to select. You 
should add/modify tender types after you have closed out all registers. 

If you add a tender type while the registers are running, you must always close all POS 
registers by performing a Z report and restarting each station. This way, the new tender 
type will appear at all the registers. 

To add a new tender type 

1. On the Database menu, click Tender Types. The Tender Types window appears. 

2. Click New. 

3. On the General tab, type the name of the tender in the Description box, and then 
continue to add all the pertinent information regarding the tender (i.e., tender code, 
tender type, currency). 

4. Click the Verification tab and enter the applicable information. The options 
presented on this tab are only enabled for the check, voucher, and credit card 
tenders. 

Tip: You can specify the order at which the tenders are displayed at the POS. 

5. Click OK to save the information.  
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Using an alias 

Aliases are useful when you want to ring up the item using a short or alternative item 
lookup code. In a way, aliases are like nicknames. In the Manager program, you can 
define or delete an alias. You can also generate an Alias report that displays all your 
aliases. 

To define an alias 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Select the item to which you want to add an alias, and then click Properties. 

3. On the Item Properties window, click the Aliases tab. 

4. Click Add to display the Add Alias window. 

5. Enter the name of the alias, and then click OK. You will see the new alias in the 
Alias box. 

6. To save the information, click OK.  
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Using substitute items 

Sometimes your store may temporarily run out of items that the customers want to 
purchase. Store Operations enables you to create substitutes (alternate options) for an 
item. For example, if one of your stores runs out of a particular brand, it can offer the 
customer another (a substitute) brand. 

In the Manager program, you can define and delete substitutes. You can also generate a 
substitute report that displays all your substitute items. 

To define a substitute 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears. 

2. Select the item to which you want to assign a substitute. 

3. Click Properties. 

4. On the Item Properties window, click the Substitutes tab. 

5. To add a substitute item, click Add to display the Items window. 

6. Select an item, and then click OK. You will see the item listed on the tab. 

7. Click OK to save the information.  
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Managing supplier information 

It is important to keep up-to-date information on your suppliers. This way, you ensure 
that your purchase orders arrive at the right place at the right time. Maintain your 
supplier database by adding, editing, or deleting suppliers' contact information. 

To add a supplier to the database 

1. On the Database menu, click Suppliers. The Suppliers window appears. 

2. Click New. 

3. On the General tab, enter all the supplier information in the applicable fields. 

4. Click the Items Supplied tab and use the Add button to add all the items that 
pertain to the supplier. After you select the item from the Items window, click OK 
to include it on the Items Supplied tab. 

Tip: You can quickly drill-down to detailed item information by moving your mouse 
over the fields in the Item Lookup Code column on the Items Supplied tab and then 
double-clicking. 

To modify supplier information 

1. On the Database menu, click Suppliers. 

2. On the Suppliers window, click Properties. 

3. In the property boxes, modify the appropriate information, and then click OK. 

To remove a supplier from the database 

1. On the Database menu, click Suppliers. 

2. On the Suppliers window, select the supplier you want to remove from the database, 
and then click Delete. 

3. When you see a window reminding you that you have selected a record for deletion, 
answer appropriately.  
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Setting up currencies 

After you set up Store Operations to use multiple foreign currencies, you can assign 
them to the applicable suppliers for use in handling purchase orders and inventory 
transfers, as well as selecting the desired currency to use at the point-of-sale. 

To set up a foreign currency 

1. On the Database menu, click Currencies. 

2. Click New to display the Currency Properties window. 

3. In the Description box, enter the name by which the currency can be referenced 
(e.g., German Mark). 

4. In the Code box, enter the ID assigned to the currency (e.g., DM). 

5. In the Exchange rate box, enter the applicable rate of exchange (e.g., 1.55). 

6. Use the Locale drop-down list box to select the place that uses the currency as a 
standard (e.g., German - Standard). 

7. Click OK to save the information. 

To assign a currency to the applicable supplier(s) 

1. On the Database menu, click Suppliers. 

2. Select the applicable supplier, and then click Properties. 

3. On the General tab, use the Accepted Currency drop-down list box to select the 
currency associated with this supplier. For example, if your supplier is in Germany, 
you could select the German Mark currency. 

4. Click OK to save the information. Whenever you use this supplier for ordering, 
Store Operations will automatically calculate the amounts in the applicable 
currency. 
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To assign a currency to the applicable tender type(s) 

1. On the Database menu, click Tender Types. 

2. Select the applicable tender type, and then click Properties. 

3. On the General tab, use the Currency drop-down list box to select the applicable 
currency that will be associated with this tender type. 

4. Click OK to save the information.  

Customizing POS buttons 

You can access websites, software packages, and application tools directly from the 
point-of-sale screen. Use the Custom POS Buttons menu option in the Manager 
program. These buttons appear on the right side of the point-of-sale transaction screen. 

To customize a POS button 

1. On the Database menu, click Registers, and then click Custom POS Buttons. 

2. On the Custom POS Buttons window, click New. 

3. In the appropriate field boxes, enter the button's number, style, caption, command, 
and description. 

4. To use a specific image, click Load, and then select an image file. When you click 
Open, Store Operations will display the image on the Custom Button Properties 
window. 

5. Click OK to save the information. 
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Creating reason codes 

You can define reason codes that will help you track information regarding customer 
discounts, inventory manual adjustments, inventory transfers, returns, no sales, etc. 

After you create the reason code(s), you can configure Store Operations to prompt and/or 
require the employee to enter the appropriate code for the applicable action (i.e., 
performing a No Sale). See also the Options tab in the Configuration menu option. 

To create a reason code 

1. On the Database menu, click Reason Codes. 

2. Click New. The Reason Code Properties window appears. 

3. In the Code field, enter the ID by which this reason code can be referenced. 

4. In the Description field, enter an explanation that describes the reason for this 
reason code (i.e., Damaged). 

5. Use the Type drop-down list box to select the type of reason code (i.e., customer 
discount, inventory adjustment, no sale, return to main inventory, etc.) 

6. Click OK.  
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Setting Net Display channels 

Before you can use the net display at the point-of-sale, you need to set up your net 
display channels in the Manager program. For detailed information about the Net 
Display Channels feature, refer to the Reference section. 

To set a net display channel 

1. On the Database menu, click Registers, and then click Net Display Channels. 

2. Click New. 

3. In the Channel Name box, enter the name of the net display channel. 

4. Click Add, and then enter the URL address and the time duration (in seconds). The 
default time is 60 seconds. 

5. When you finish defining the net display channel(s), use the Move Up and Move 
Down buttons to change the position order. You can also select a channel and click 
Preview to confirm the address. 

6. Click OK to save the information. 

After you define your net display channels, you can access them from the POS. 

To use the net display channels at the POS 

1. In the POS program, press CTRL-F6. 

2. On the Display Properties window, select the 'Show Net Display' option. 

3. Define the Position and Width for the net display. 

4. In the Filename box, select the receipt template. You can reconfigure the standard 
template provided with the installation by modifying the HTML file. 

5. Click Windows to define the window options, and then click OK. 

6. When you finish defining the net display options, click OK. You will then see the 
net display channel.  
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Controlling pricing, sales, and promotions 

Adjusting item pricing 

You may have already set up your initial pricing structure. However, as you continually 
add to your inventory, you should define the item price and cost at the same time you 
add the item. See also Working With Your Database. 

You can adjust item pricing a couple of ways. If you want to change the pricing of one 
item, you can find it in the database and manually modify its pricing properties. 

Another way to change the price/cost of multiple items is to use the Inventory Wizard, 
which automatically updates prices and costs of selected items all at once. 

To change the cost of a single item 

1. On the Database menu, click Items, and then click Item List. 

2. Select the item whose cost you want to change, and then click Properties. 

3. On the Item Properties window, click the Pricing tab. 

4. In the Cost box, enter the item's cost, and then click OK. 

Note: If the Cost box is grayed out and you can not edit the costs, you may not have the 
necessary access rights for this feature. 

To change the price of a single item 

1. On the Database menu, click Items, and then click Item List. 

2. Select the item whose price you want to change, and then click Properties. 

3. On the Item Properties window, click the Pricing tab. 

4. In the Price box, enter the item's price, and then click OK. 
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To change the prices of multiple items 

1. On the Wizards menu, click Inventory Wizard. The Inventory Wizard appears. 

2. Click Next to display the 'Select the Task to Perform' window. 

3. Use the drop-down list box to select the task you want to perform. To change the 
item prices, select Task 110: Change Item Prices. Then click Next. 

4. Select the items you want to update. For example, you can update items by 
departments, categories, or suppliers. Or, you can add the items manually. Click 
Next. 

5. Select the item price change method (i.e., discount from regular cost, markup from 
cost), the price to be changed (i.e., Regular, Level A), enter the desired percentage, 
and then click Next. 

Note: If you selected the Add Items Manually option, some of the fields on this 
window may be grayed out (not editable). 

6. To round your updated prices to retail values, select the Perform Price Rounding 
option, and then select the applicable Rounding Method option. If you have never 
defined the rounding rules, click Rules to set up the rounding structure. To continue 
to the next wizard screen, click Next. 

If you do not wish to perform price rounding, click Next to continue. 

7. If you do not want to change any of the information, click Finish to display the 
Inventory Wizard Workpad. 

8. If all the information is correct, click Commit to apply the changes to your 
database. If you selected the Add Items Manually option, you need to enter the 
applicable items before you can commit them. If you edit the information, either 
enter the data in the appropriate entry box or right-click your mouse to use the 
additional commands. To cancel all the changes, click Cancel.  
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Defining weekly sales schedules 

You can set up weekly schedules for sales prices to be effective for desired items. You 
can also create a schedule that would block the sale of items for specific days or times. 

Note: After you create a weekly schedule, use the Pricing tab and/or Options tab in the 
Items menu option to assign the schedule to the applicable item(s). 

To define a weekly schedule 

1. On the Database menu, click Schedules. The Weekly Schedules window appears. 

2. Click New. 

3. In the Description field, enter the name by which this schedule can be referenced 
(i.e., "Happy Hour"; Lunch Special, etc.) 

4. In the Time Increments field, use the available drop-down list box to select the 
time increment of 15 minutes, 30 minutes, or 1 hour. The grid will vary depending 
on the specified time period. 

5. On the grid schedule, click on the desired time box for when you want the sales 
price / blocked sales to be in effect. For example, if you wanted an item's sales price 
to be in effect from 12:00 p.m. to 1:00 p.m., click the 12:00 pm -1:00 pm box for the 
applicable day(s). To highlight multiple time periods, drag your mouse over the 
applicable boxes. 

6. After you click the desired time box, click Set. Store Operations will highlight the 
field(s) in red showing that each time period was added to the weekly schedule. 

7. When you finish defining the weekly schedule, click OK to save the changes. 

8. Use the Items menu option's Pricing tab or Options tab to assign this schedule to 
the applicable item(s). For detailed instructions, refer to the Putting Items on Sale 
topic. 

Tip: To select all the field boxes for an entire column or row, click the column or row 
header, and then click Set.  
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Putting items on sale 

You may be getting ready to promote your grand opening or holiday sale, and you want 
to set up all your sale prices days in advance. When you put your item(s) on sale, you 
should specify the sale start date and end date. The sale prices take effect at the 
designated time period. When customers purchase an item on sale, they pay the sale 
price unless they have a discount that specifies a lower price. After the end date, the sale 
price returns back to the normal price. 

You can change the price at the point-of-sale, provided that your user ID has access 
rights to override the price. To ensure that the cashier does not sell an item below its 
lowest price, you can define a price range for the item. Store Operations displays a 
message when the cashier changes the item price to below its lowest allowable price. 

To put multiple items on sale, use the Inventory Wizard to save effort and time. 

To put a single item on sale 

1. On the Database menu, click Item, and then click Item List. 

2. Select the item whose sale price you want to define. Then click Properties. 

3. On the Item Properties window, click the Pricing tab. 

4. Under the Sale Pricing heading, select the This item is on sale option. 

5. In the Sale Price field, enter the applicable sale price. 

6. Select either the This sale is in effect for a specific period option or the This sale 
is in effect according to a schedule option. 

7. Use the associated drop-down list box to select the applicable dates or weekly 
schedule. Note that you can use the Schedules menu option to define weekly 
schedules. 

8. Click OK to save the information. 
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To automatically put multiple items on sale 

1. On the Wizards menu, click Inventory Wizard. The Inventory Wizard appears. 

2. Click Next to display the 'Select the Task to Perform' window. 

3. Using the drop-down list box, click Task 110: Change Item Prices. Then click 
Next. 

4. Select the items you want to put on sale. Click Next. 

5. Select the price change method and price to be changed. In the Date Range box, 
type or select the part of the date you want to change. Click Next. 

Note: If you selected the Add Items Manually option, some of the fields on this 
window may be grayed out (not editable). 

6. To round your updated prices to retail values, select the Perform Price Rounding 
option, and then select the applicable Rounding Method option. If you have never 
defined the rounding rules, click Rules to set up the rounding structure. To continue 
to the next wizard screen, click Next. 

If you do not wish to perform price rounding, click Next to continue. 

7. If you do not want to change any of the information, click Finish to display the 
Inventory Wizard Workpad. 

8. If all the information is correct, click Commit to apply the changes to your 
database. If you selected the Add Items Manually option, enter the applicable items 
before you commit them. To cancel the changes, click Cancel.  
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Setting up discount schedules 
Define the mix and match category for selected items or set up various "Buy X, Get Y" 
discounts. Mix and match items are items that can be bought in quantity with other 
similar mix and match items for a discounted price. For example, assume that candy bars 
A and B are each normally sold for $0.40, and their mix and match pricing structure 
prices three candy bars for $0.99. Any combination of candy bars A and B that add up to 
a quantity of three will result in a total charge of $0.99, instead of $1.20. All items in the 
mix and match scheme will be the same price. 

The "Buy X, Get Y" discount feature lets you sell a specified quantity ("X") of items at 
full price and give the customers a certain number ("Y") of items for free or at a 
discounted price. For example, if customers buy three T-shirts, they can receive another 
T-shirt for free. Pick and choose the desired discount schedules. 

To define a mix and match category 

1. On the Database menu, click Discounts. 

2. Click New. 

3. In the Description field, enter a name by which this mix and match category can be 
referenced. 

4. Select the Mix and Match pricing option. 

5. Set up the pricing schedule by entering the applicable quantities and their associated 
extended prices. 

6. Select or clear the Discount Odd Items option. 

7. Click OK to save the information. 

8. Use the Items menu option's Discounts tab to assign the mix and match pricing 
structure to the applicable item(s). 
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To set up a "Buy X, Get Y" discount 

1. On the Database menu, click Discounts. 

2. Click New. 

3. In the Description field, enter a name by which this discount can be referenced. 

4. Select the Buy X and Get Y for Z option. 

5. In the Quantity to Buy at Full Price box, enter the quantity the customers need to 
buy before they can receive the discount on additional items. This is your "X" value. 

6. In the Quantity to Get at Discount box, enter the quantity the customers receive at 
discount. This is your "Y" value. 

7. In the Discount Price box, enter the price at which the discounted items will be 
sold. If the customers receive these items for free, enter the number "0" (zero). This 
is your "Z" value. 

8. Click OK. 

Note: Assuming you wanted to create a "Buy 2 items, get the 3rd item for free" 
structure, you would enter the number "2" in the Quantity to Buy at Full Price box and 
the number "1" in the Quantity to Get at Discount box. Because you are giving the 
third item for free, you would enter the price $0.00 in the Discount Price box.  
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Providing a gift with purchase 

You can assign a promotional/gift item to certain items in your database. This way, when 
customers purchase a particular item, Store Operations automatically includes the gift 
item in the sale. You can also designate the quantity of the gift item you want to give 
away with the purchase. 

Before you can provide a gift with purchase, you must first create the gift item and then 
assign it as a Tag Along Item for the desired items in your database. 

To create a gift/promotional item 

1. On the Database menu, click Items, and then click Item List. 

2. Click New to create the gift/promotional item. 

3. On the General tab, enter the applicable item information, including the item 
lookup code, description, and/or department and category. 

4. Use the Item Type drop-down list to select the applicable item type. If you want to 
track this promotional item, select Standard. If, however, you do not want to track 
the item, select Non-Inventory. 

5. Use the available tabs on the Item Properties window to enter all the necessary 
information concerning the item. 

6. Click the Pricing tab. 

7. Because you plan to give away this item at no cost to the customer, confirm that 
there is a zero balance ($0.00) in the Price field. 

8. Click OK to save the information. 

After you create this item, you need to assign it to the applicable items. For example, 
assume that you want to give away a football whenever a customer purchases an item 
that costs more than $50.00. You would then need to assign the football as a tagalong 
item for each item whose cost is higher than $50.00. 
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To assign the gift to an item 

1. On the Database menu, click Items, and then click Item List. 

2. Select the applicable item (e.g., helmet), and then click Properties. 

3. Click the Special tab. 

4. In the Tag Along Item field, click the Browse  button to select the gift item 
(e.g., football) from the database. Store Operations will display the gift item's 
lookup code in the field. 

5. In the Quantity field, enter the number of gift items you want to include with the 
item. 

6. Click OK to save the information. 

Every time the customer purchases the particular item, Store Operations automatically 
includes the gift item in the sale. For example, when customers purchase the helmet, 
Store Operations automatically includes the football in the sale. If desired, the cashier 
can delete the gift item at the POS.  
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Tracking inventory 

Store Operations enables you to manage and track your inventory by continually 
recording changes to increases or decreases in your on-hand quantities. You can also 
generate purchase orders and inventory transfers, track offline inventory (items not for 
sale), and process online shipping. 

Read the following sections and learn how to: 

! Identify what you have in stock 

! Generate and process purchase orders 

! Use inventory transfer in and transfer out orders for single store and multi-store 
operations 

! Work with your offline inventory 

! Define shipping carriers and services 
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Identifying what you have in stock 

You can track your item quantities a couple ways. You can either locate the item(s) 
directly in the Store Operations database or generate a report that displays all your 
quantity information. 

Note: You can also track inventory offline. For details, refer to the Working with Offline 
Inventory topic. 

To look up item quantities 

1. On the Database menu, click Items, and then click Item List. The Items window 
appears, which organizes items according to item lookup code, item type, 
description, available quantity, and price. 

2. Using the Up/Down-Arrow keys, select the appropriate item. To see that item's 
quantity levels, look at the number in the Available Qty box. 

3. Click Properties and then click the Inventory tab to view the selected item's 
detailed quantity information. This way, you can identify your on-hand quantity, 
committed quantity, reorder point, and restock level. You will also know the date 
that you last received the item and the last date the item was sold. 

You can also identify what you have in stock by generating an Item Quantity List report, 
which displays detailed quantity information for all your items. 

To generate an Item Quantity List Report 

1. On the Reports menu, click Items, and then click Quantity List. 

2. Specify the filter criteria as desired, and then click OK. You will see your entire 
item list with all the available quantities. 

3. If desired, sort the data. 

Tip: To quickly display the properties for a specific item, double-click on the Item Lookup 
Code field directly on the report preview screen.  
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Purchase orders 
Use the Purchase Orders menu option to generate, edit, delete, print, receive, and report 
the status of purchase orders to your suppliers. By generating organized purchase orders, 
you can better determine what is ordered and what is received. 

The Purchase Orders feature enables you to perform two main jobs: 

! Creating purchase orders 
! Receiving items from purchase orders 

Whenever you need to order items, you can create a purchase order, edit it, print it out, 
and send it to the selected supplier(s). Then, when you receive the shipment, you will use 
this option again to enter the quantities you received and add them to your database.  

Generating a purchase order 
Whenever you want to order items from your supplier(s), generate a purchase order. 

To generate a new purchase order 

1. On the Inventory menu, click Purchase Orders.  

2. On the Purchase Orders window, click New to create a new purchase order. 

3. Under the Generation Selection heading, select the criteria Store Operations will 
use to order the items. This criteria includes generating new purchase orders based 
on manual entry, items in a selected group, re-order information, and items sold. 

4. Under the Group Selection heading, select the grouping method by which you will 
add the items. 

5. Under the Supplier Selection heading, select the applicable supplier option. 

6. Click OK. 

7. If you selected the 'Create a new blank purchase order for manual entry' option, 
you can edit the order by selecting the items to add to the purchase order. If you 
selected one of the other options, you will see a window that tells you how many 
purchase orders Store Operations created based on the selected criteria. When this 
window appears, click OK. 

After you create purchase orders, you can edit them at any time. When your shipment 
arrives, use the Purchase Orders menu option again to receive the order and commit the 
inventory to your database.  
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Editing a purchase order 

Sometimes you will need to modify information on your purchase order before it is sent 
to your supplier. For example, you may need to add items or change the quantity you 
ordered. 

To edit a purchase order 

1. On the Inventory menu, click Purchase Orders. The Purchase Orders window 
appears. 

2. Select the purchase order whose information you want to enter or modify, and then 
click Edit. 

3. On the Edit window, enter or modify the necessary information, such as PO number, 
shipment, and title on the Header tab. 

4. Click the Contents tab, and then modify as applicable the content details, such as 
item description, order number, and quantity ordered. 

5. If you need to add an item to the order, click Add Item and then select the item 
from the list. You can also click Quick Scan and scan in the applicable items. 

6. When you finish modifying the purchase order information, click OK. 

Tip: As you move the mouse over the Edit window, you will sometimes see a magnifying 
glass appear in place of the cursor, which means that you can view or edit that individual 
item. Double-click your mouse to display the detailed item information.  
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Receiving a purchase order 

Whenever you receive your purchase order shipment, you can record the items and add 
them to your database. 

To receive a purchase order 

1. On the Inventory menu, click Purchase Orders. 

2. On the Purchase Orders window, select the desired purchase order, and then click 
Receive. 

3. Click the Contents tab. 

4. In the Qty Rcv box, enter the quantity amount you received for each item. If you 
received the entire purchase order, click Receive All, which will automatically set 
the quantity received to the quantity ordered. 

Note: If you are receiving serialized items, place your cursor in the Qty Rcv box, 
and then click the Details  button. On the Serialized Item Detail window, click 
Add to enter the applicable serial number(s). 

5. After you enter the quantities received, click Commit to add the actual quantities to 
your database. This button enables you to update the database and add the item 
quantities to the current in-stock quantities. 

Note: To keep all the item quantities in the Receive Inventory Item List without 
affecting the database, click OK instead of Commit. 

6. When you see a window asking if you want to continue, click Yes. 

7. If you only partially received the items, Store Operations will display a window that 
asks if you want to close the purchase order. If you click Yes, Store Operations will 
set the Quantity Ordered equal to the Quantity Received to Date. If you click No, 
the purchase order will remain "open" until you receive all the items or close the 
order.  
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Printing a purchase order 

After you create your purchase order, you can print it out to send to your supplier(s). To 
print a purchase order, go to the Inventory menu, click Purchase Orders, select the 
desired purchase order, and then click Print. 

Although you would usually print the purchase order to a printer, you can also use the 
Print function to export the "printed" purchase order to a mail message. You must, 
however, make sure that the computer is properly configured for Microsoft Mail 
services, or you need to directly export it to a specifically formatted file. 

It is the file attached to the mail message that would normally be printed to a printer. 
This way, you could send a purchase order to another person to review without printing 
out a hard copy. Also, the exported file is directly formatted for the file format chosen so 
that a file format compatible application may open the "printed" purchase order. For 
example, if you select Word for Windows as the format, you can then use Microsoft 
Word to open the exported file.  
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Inventory transfers 
Whenever you need to add items to your inventory without actually transferring money, 
use Store Operations’s Transfer Inventory In and Transfer Inventory Out menu 
options. This way, you can add items to your database and record the progress. 

! Transfer Inventory In - Enter items received from your suppliers (or items 
transferred from other stores) without generating a purchase order. The Transfer 
Inventory In option helps you add items to your database without affecting your 
costs. The process for receiving transfer inventory orders is very similar to that of 
purchase orders. Whether you have a single store or multi-store operation, you can 
use this option to receive items into your inventory database. 

! Transfer Inventory Out - Transfer items to other stores or remove items from your 
inventory, and also record the process. This option is used mainly for enterprise 
operations, but you can use it to record items taken out from your inventory that do 
not affect your overall costs.  

Single store operation - Transfer inventory in 

As you operate your single store, there may be times when you receive items from a 
company (i.e., your supplier) that do not involve the transfer of money. For example, 
whenever you send an item to the supplier for repairs, you need to account for the 
temporary change in inventory. The following example explains how to add and remove 
items to and from your inventory. 

To generate a transfer inventory in order 

Assume that you returned three bikes to your supplier to have defective brake pads 
replaced. Your supplier just called and let you know that they will be shipping the 
repaired bikes back to you. Use the Inventory Transfer In menu option to account for 
these items when they come in. 

1. On the Inventory menu, click Transfer Inventory In. 

If you have used this option before, you may see completed or in-progress transfer 
orders already listed on this window. If you have never used this option, the window 
will be blank. 

Because you are expecting three bikes, you need to log the transfer inventory in 
request so when the order arrives, you can quickly add the items to your database. 
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2. On the Transfer Inventory In window, click New. The Create Inventory Transfer 
In Orders window appears, which lets you select the criteria Store Operations will 
use to generate the transfer order. This criteria includes generating new inventory 
transfers based on manual entry, items in selected groups, re-order information, and 
items sold. 

3. Under the Generation Selection heading, select the grouping method by which you 
will add the items. For example, you can generate a new inventory transfer in order 
based on all the items sold within a specified time period. 

4. Depending on the option you choose, you may need to select an option under the 
Group Selection heading. For example, you can generate transfer orders for items 
in selected departments and categories. 

5. Click OK. 

6. If you selected the 'Create a new blank inventory transfer in order for manual 
entry' option, you can edit the order by entering information regarding the order in 
the Header and Contents tabs. If you selected one of the other options, you will see 
a window that tells you how many transfer in orders Store Operations created based 
on the selected criteria. When this window appears, click OK. 

7. After you generate your inventory transfer in order(s), you can modify the 
information by clicking Edit on the Transfer Inventory In window. 

8. Click the Header tab and enter/modify the applicable information, including 
inventory transfer Number, Title, Transfer From, etc. 

9. Click the Contents tab. If you want to add items to the order, click Add Item and 
select the applicable item from the list. You can also click Quick Scan to quickly 
scan/enter the item lookup code or item alias. Select or clear the Use Supplier MPQ 
(Master Pack Quantity) option. 

10. Once you select the item, click OK. 

11. In the Qty Ord field, enter the amount you expect to receive. For example, if you 
expect to receive three bikes, enter number "3". 

12. After you finish entering the information, click OK. 

Now, you just need to wait for the bikes to arrive. 
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To receive items into the database 

Assume that it is now the following day and you received the shipment. You discover 
that your supplier sent you two out of the three bikes. You can go ahead add these items 
to your database. 

1. On the Inventory menu, click Transfer Inventory In. 

2. Select the applicable transfer in order (the one you previously created) and then 
click Receive. 

3. Click the Contents tab. 

4. If you received all the items, click Receive All. If, however, you received a partial 
amount, enter the amount(s) in the Qty Rcv box. Because these bikes are serialized 
items, you need to specify which serial numbers you are receiving. Place your 
cursor in the Qty Rcv field, and then click the Details  button. 

5. On the Serialized Item Detail window, click Add to enter the serial number of the 
bike you received. In the Serial Number field, enter the applicable serial number. 

6. Because you received two out of the three expected items, click Add again to enter 
the second serial number. 

7. Click OK. You will then see the number "2" in the Qty Rcv field. 

8. When the items have been correctly received, you must click Commit to apply the 
changes to the database. 

9. When you see a window box asking if you want to add the quantities to your 
database, click Yes. 

10. If you only partially received the items, Store Operations displays a window that 
asks if you want to close the transfer order. If you click Yes, Store Operations will 
set the Quantity Ordered equal to the Quantity Received-to-Date. If you click No, 
the transfer order remains "open" and allows you to update the order until you 
receive all the items or close the order. 

The Transfer Inventory In window displays the status of the order. If you received the 
entire order, there will be a yellow worksheet to the left of the item description, 
indicating that all items have been received. If you did not receive the entire order (using 
our example, we need one more), you will see a red exclamation mark on a white 
worksheet. If and when you receive the other bike, use the Transfer Inventory In menu 
option to receive the shipment. 

Click Print to generate an inventory transfer report for your records.  
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Single store operation - Transfer inventory out 

Whenever you need to transfer items out of your store that do not affect your overall 
costs, use the Transfer Inventory Out menu option. This option enables you to record 
the decrease in inventory. There are many different reasons why you would transfer out 
items. For example, you may need to return items to your supplier for repair. Or, if Store 
A needed a particular item, you could use this option to send the requested item from 
Store B to Store A. 

To generate a transfer inventory out order 

Assume you need to return five road safety kits to your supplier for repair. Use the 
Inventory Transfer Out function to process this transfer. 

1. On the Inventory menu, click Transfer Inventory Out. 

If you have used this option before, you may see completed or in-progress transfer 
out orders already listed on this window. If you have never used this option, the 
window will be blank. 

2. On the Transfer Inventory Out window, click New. A new order will be created and 
you will see the Edit - Inventory Transfer Order window. (To change an existing 
order, click Edit.) 

3. On the Header tab, enter the applicable information, including inventory transfer 
Number, Title, Ship To, etc. 

4. Click the Contents tab. 

5. Because you want to add the road safety kit item to the order, click Add Item and 
select the applicable item from the list. You can also click Quick Scan to quickly 
scan/enter the item lookup code or item alias. Select or clear the Use Supplier MPQ 
(Master Pack Quantity) option. 

6. Once you select the road safety kit item, click OK. You will see the item in the 
Inventory Transfer Out Contents list. 

Tip: To quickly look up information for the specific item, position the cursor over 
the Item Lookup Code field until the cursor changes to a magnifying glass. Double-
click your mouse to display the Item Properties window for the selected item. This 
way, you can find the item's detailed information. 

7. The Qty OH field displays the on-hand quantity for that specific item. In the Qty 
Ord field, enter the number of road safety kits you want to transfer out of your 
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store. 

8. Click OK to return to the Transfer Inventory Out window. If you use the Filter 
drop-down list and select Show Open, you will see the order you just created. 

9. On the Transfer Inventory Out window, select the order you just created, and then 
click Issue. 

10. Click the Contents tab. To send the entire order, click Issue All. If you can only 
send a partial amount, enter that number in the Qty Iss box. 

11. Click Commit to subtract the quantities from the item database. 

12. Store Operations displays a window confirming that you want to add the items to the 
database. Click Yes to continue. 

13. If you only partially received the items, Store Operations displays a window that 
asks if you want to close the transfer order. If you click Yes, Store Operations will 
set the Quantity Ordered equal to the Quantity Received-to-Date. If you click No, 
the transfer order remains "open" until you receive all the items or close the order. 

14. On the Transfer Inventory Out window, use the Filter drop-down list to select what 
type of transfer out orders you want to see. Store Operations lists the applicable 
orders with their present status. If you shipped the entire order, you will see a yellow 
worksheet to the left of the order indicating that all items have been issued. If you 
shipped only a partial amount, you will see a red exclamation mark on a white 
worksheet. 

You can then print a copy of the order for your records or as shipping paper. 

Note: The procedures for transferring serialized items vary slightly.  
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Working with your offline inventory 

Store Operations enables you to store and track inventory offline (items not for sale). 
This feature is especially useful for managing items that are damaged and have been 
returned, as well as items that you do not yet stock on shelves, plan to transfer out, or 
want to keep separate from your main inventory. 

After you add the item to your offline inventory, you can either leave it offline or process 
one of the following functions: 

! Send item to inventory transfer out order 

! Transfer item to main inventory 

To add an item to offline inventory 

1. On the Inventory menu, click Manage Offline Inventory.  

2. Click Add. 

3. On the Items window, select the item you want to add to the offline inventory, and 
then click OK. The New Offline Inventory Entry window appears. 

4. In the Reason Code field, click the Browse  button or press F2 to display a list 
of the applicable reason codes. If your store does not use reason codes, you can 
leave this field blank. Select the appropriate reason code, and then click OK. 

5. In the Comment field, you can enter an explanation why the item will be a part of 
the offline inventory. 

6. In the Quantity field, enter the number of items to move to the offline inventory. 
For example, if 12 out of 35 bicycle helmets were damaged, you could enter the 
number '12' in this field. 

Note: If you are adding a serialized item, the Quantity field will be disabled. Click 
Add on the New Offline Inventory Entry window to select the applicable serial 
number(s). On the Serial Number Selection window, either drag your mouse over 
the desired serial numbers or click on the appropriate serial number. When you click 
OK, Store Operations will automatically update the Quantity field and display the 
specified serial number(s). 

7. On the New Offline Inventory Entry window, click OK. In this example, Store 
Operations would subtract 12 helmets from your on-hand quantity for your main 
inventory, and then display the number '12' in the Offline Qty field on the Offline 
Inventory window. 
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To transfer out item from offline inventory 

From your offline inventory, you can transfer out selected items. For example, you can 
transfer all the damaged item(s) to the manufacturer for repair. 

1. On the Inventory menu, click Manage Offline Inventory. 

2. On the Offline Inventory window, select the item you want to transfer out, and then 
click Transfer Out. 

3. Store Operations will automatically transfer the number of items as displayed in the 
Offline Qty field, and place them in the Contents tab of the Inventory Transfer Out 
order. 

4. Complete the transfer order as necessary. For detailed instructions, refer to the 
Transfer Inventory Out topic in the Inventory Transfers section. 

5. On the Offline Inventory window, Store Operations will place the order number in 
the Transfer # field. You can double-click this field to display the transfer order. 

Note: You can transfer out all the items in the list by clicking the Select All button and 
then right-clicking your mouse to select the Transfer Out option. 

 To transfer item to main inventory 

You can transfer items from your offline inventory to your main inventory. 

1. On the Inventory menu, click Manage Offline Inventory. 

2. On the Offline Inventory window, select the item you want to send to the main 
inventory, and then click the To Main button. 

3. Store Operations will automatically send the number of items as displayed in the 
Offline Qty field to the main inventory.  
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Defining shipping carriers 

With an Internet connection, Store Operations can use UPS and FedEx Websites to fill in 
shipping manifest, generate shipping labels, and track deliveries. Customers can track 
shipments on-line at UPS or FedEx Web sites.  

After you define your shipping carriers and services, use the Configuration menu option 
to set up your default shipping carrier and/or service to use at the point-of-sale. 

To define shipping carriers and services 

1. On the Database menu, click Shipping Carriers. The Shipping Carriers window 
appears. 

2. Click New. 

3. On the General tab, enter the name of the applicable shipping carrier (e.g., Federal 
Express). 

4. Under the Internet Addresses heading, enter the shipping carrier's URL addresses 
for the home page, shipping page, and tracking page. 

5. To add the shipping carrier services your company will use, click the Services tab. 

6. Click the Add button. 

7. In the Server name box, enter the name of the service (Priority Overnight). 

8. Under the Schedule of Charges heading, specify the method by which Store 
Operations will calculate the shipping charge. 

9. In the available grid, enter the applicable denominations. For example, if you 
selected the Weight option, you could enter the number '100' in the Weight field 
and the price '$10.00' in the Charge field. 

10. Select or clear the Interpolate Schedule option. 

11. Click OK to save the information.  
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Tracking sales 

Viewing and analyzing sales data 

To help you keep on top of all your sales figures and inventory needs, Store Operations 
tracks the goods and services you sell to your customers. One of the best ways to view 
and analyze your data is to use Store Operations’s Active Reports. Generate any of these 
reports by going to the Reports menu and clicking on the desired report. There are a 
number of reports you can use to view your sales data. On the report preview screen, sort 
and filter the report data as desired. 

Note: After you click on the desired report from the Reports menu, you may see the 
Report Filter window, which enables you to specify the necessary filter criteria. To 
generate the report, click OK. 

! Summary Sales (Daily) reports - To see a quick summary of your daily sales, go to 
the Reports menu, click Sales, and click Summary Sales (Daily), and then select 
the type of sales report that will give you the desired information. View sales data 
by sales rep, cashier, supplier, register, category, and department for the current 
date, week-to-date, month-to-date, and/or year-to-date. 

! Summary Tax Collected (Daily) report - To quickly calculate how much tax you 
need to pay, generate the Summary Tax Collected (Daily) report. This way, you can 
see the sales tax rate (%) for each type of tax (i.e., county tax, local tax, partial 
dollar). You can also view the sales tax total for the current date, week-to-date, 
month-to-date, and year-to-date. To generate this report, go to the Reports menu, 
click Sales, and then click Summary Tax Collected (Daily). 

! Detailed Sales report - To see all your pertinent sales information, generate the 
Detailed Sales report. The report displays everything from supplier and item 
information to quantity and price levels. To generate this report, go to the Reports 
menu, click Sales, and then click Detailed Sales. 

! Detailed Tax Collected report - Generate the Detailed Tax Collected report to 
view and calculate your sales taxes. This way, you can analyze all your key sales tax 
information, including tax description, sales tax rate (%), batch and register 
numbers, opening and closing dates, and total tax collected. To generate this report, 
go to the Reports menu, click Sales, and then click Detailed Tax Collected. 
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! Top Performers reports - To immediately know who or what is performing the 
best in your store, generate the Top Performers report. When you go to the Reports 
menu, click Sales, and then click Top Performers, you can choose from a number 
of different reports that show you the top performers in a particular category. For 
example, use the Top Items report to quickly identify your fastest moving items. Or, 
use the Top Cashiers report to know which cashiers are selling the most items 
during a particular time period. 

! Regional Sales report - Use the Regional Sales report to track customer 
demographics. Store Operations organizes the sales data by customers' zip codes. 
The report also displays the city, state, date, sales, and profit margin information, 
enabling you to identify which zip codes (regions) are the strongest and weakest. 
This way, you can adjust your advertising and marketing efforts to focus on those 
specific regions that will improve your overall sales totals. To generate this report, 
go to the Reports menu, click Sales, and then click Regional Sales. 

! Department Cost/Sales report - If you organized your items into departments 
and/or categories, you can generate the Department Sales Report to view the total 
sales, cost, and profit margin information for each department. To generate this 
report, go to the Reports menu, click Sales, and then click Department Cost/Sales. 

! Sales Commission report - The Sales Commission Report enables you to see the 
commission totals for each sales representative. To generate this report, go to the 
Reports menu, click Sales, and then click Commission. 

Remember - After you generate a report, you can access detailed information directly 
from the report preview screen. Move your mouse cursor over the report, and whenever 
you see a "magnifying glass," double-click your mouse. You will then see that selected 
entry's specific data.  
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Tracking quotes, orders, and layaways 

Generating Store Operations’s reports gives you an overall view of your sales 
information. Once you generate a report, sort and filter the report data as desired. You 
can also access detailed database information directly from the report preview screen. 
Just move your mouse cursor over the report until it displays a magnifying glass. Then 
double-click your mouse to display the detailed information. 

Sales quotes reports 
To generate one of the sales quotes reports, go to the Reports menu and click 
Quotes/Orders. Then select either Quotes-Detailed or Quotes-Summary. 

! Quotes Detailed report - List sales quotes and their associated customer account, 
reference number, generation date, and price information. 

! Quotes Summary report - Summarizes the sales quotes to provide invoice number, 
date, customer account information, total amount, and deposit. 

Back order reports 
To generate one of the back order reports, go to the Reports menu and click 
Quotes/Orders. Then select either Backorders-Detailed or Backorders-Summary. 

! Back Orders Detailed report - Lists items on each back order that matches the 
selection criteria. 

! Back Orders Summary report - Provides a summary of back orders that match 
selection criteria. 

Work order reports 
To generate one of these reports, go to the Reports menu and click Quotes/Orders. 
Then select either Work Orders-Detailed or Work Orders-Summary. 

! Work Orders Detailed report - Displays past work orders and their associated 
customer accounts, reference numbers, dates, item information, quantities, and 
prices. 
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! Work Orders Summary report - Summarizes past work orders and their 
associated reference numbers, dates, cashier information, item comments, sales 
totals, and deposit amounts. 

Layaway reports 
Use Store Operations’s Active Reports to view and analyze all the information that 
pertains to layaways. Generate either layaway report by going to the Reports menu, 
clicking Layaway, and then clicking either Layaways Summary or Layaways 
Detailed. On the report preview screen, sort and filter the data as desired. 

! Layaways Summary report - Lists layaways and their associated status. Provides 
summary information, including customer accounts, expiration date, sub-total, tax, 
order total, deposit amount, and reference number. 

! Layaways Detailed report - Lists layaways and their associated detailed 
information, including customer name and account number, expiration date, item 
lookup code and description, quantity ordered, pricing information, quantity 
received, quantity on layaway, etc.  
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Managing customers 

Store Operations enables you to create and maintain a detailed database for your 
customers. To add to or modify your customer database, go to the Database menu and 
click Customers. You will see a list of all your customers. 

Whenever you create a local customer account, you can track the customer's detailed 
information, including billing and credit information, shipping address, purchase history, 
and account record. If you have several stores using Store Operations, a customer can 
have an account at each location; however, Store Operations will not consolidate 
purchases and payments from all the stores. 

Read the following sections and learn how to: 

! Set up local customer accounts 

! Recall a specific customer invoice 

! Adjust customer accounts 

! Close current billing cycle and print statements 

! Reprint account statements 

! Generate customer reports 
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Setting up local customer accounts 

Store Operations helps you to view, create, and maintain a detailed up-to-date customer 
list that you can eventually use as a foundation for mass mailings and for gathering 
useful information at the point-of-sale. If you use store-credit accounts, you will use 
customer information frequently. If you have the necessary access privileges, you can 
create and edit customer information either in the Manager program or at the POS 
screen. 

To look up customer information 

1. On the Database menu, click Customers. The Customers window appears. 

2. Select the applicable customer, and then click Properties. You will see the 
Customer Properties window, which displays the customer billing information, 
purchase history, account history, shipping address, and other information. 

To add a customer to the database 

1. On the Database menu, click Customers. 

2. On the Customers window, click New. You can also click Copy to copy values from 
an existing record. 

3. To automatically generate the customer account number, click Auto. 

4. Use the tabs on the Customer Properties window to enter the appropriate customer 
information. 

5. Click OK. 

To modify customer information 

1. On the Database menu, click Customers. 

2. On the Customers window, select the applicable customer, and then click 
Properties. You will see the Customer Properties window. 

3. Edit the appropriate information, and then click OK. 
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To remove a customer from the database 

1. On the Database menu, click Customers. 

2. On the Customers window, select the applicable customer, and then click Delete. 

3. Store Operations displays a window warning you that once you delete a customer, 
you can not undo the operation. If you want to permanently delete the customer 
from the database, click Yes. To cancel the operation and return to the Customers 
window, click No.  

Recalling a specific customer invoice 

For various reasons (e.g., settling a payment dispute), you may need to recall a receipt 
regarding a particular customer invoice. 

To recall a specific invoice 

1. On the Database menu, click Customers. 

2. Select the applicable customer account, and then click Properties. 

3. Click the Account Information tab. You will see the customer's detailed account 
information, including account type, existing balance, and available credit. 

4. Click the Activity/Receivables button to display either the customer's account 
history and running balance or the individual account receivables and the balance 
due for each invoice. 

5. Select the applicable account receivable/invoice, and then click Receipt. To view 
the payment history for the invoice, click Details. 

6. When you click Receipt, you can identify the register, batch, and receipt numbers as 
well as the cashier, date, and time. 

7. To print the receipt, click Print. To print the word "DUPLICATE" on the receipt, 
select the Include Watermark option.  
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Adjusting customer accounts 

In addition to viewing a selected customer's individual invoices, you can adjust the 
customer's account information by modifying the debit or credit transaction amounts. 

Note: The adjustments are permanent and cannot be undone. The only way to cancel an 
adjustment is to make another adjustment. Also note that whenever you make an 
adjustment to the account, the adjustment will not transfer through the General Ledger to 
accounting. 

To adjust a customer's account 

1. On the Database menu, click Customers. 

2. Select the applicable customer account, and then click Properties. 

3. On the Customer Properties window, click the Account Information tab. 

4. Select the applicable invoice, and then click Adjust. 

5. On the Adjust Customer Account window, modify the appropriate information, and 
then click OK.  



 

88      Store Operations Userís Guide  

Closing current billing cycle and printing statements 

Before you can print customer account statements in Store Operations, you must first 
close the billing cycle. Closing the billing cycle calculates all the purchases on account, 
payments, account adjustments, and finance charges between the last closing date and 
the current closing date. At the same time you close the billing cycle, you can print 
statements to send to your customers. 

Use the Close Billing Cycle option only if you have configured both customer charge 
accounts and finance charges for your store. 

To set your closing date 

1. On the File menu, click Configuration. 

2. On the Configuration window, click the Accounts tab. 

3. Enter the day of the month that accounts will be closed on. For example, if you want 
your billing cycle to end on the last day of the month, enter "31", and Store 
Operations will use the last day regardless of the number of days in the month. 

4. Click OK. 

To close the billing cycle 

You can close your billing cycle any day AFTER your Monthly Closing Date. 

1. On the Journal menu, click Close Billing Cycle. 

2. Under the Options heading, select the Close billing cycle for all customers option. 

3. Select or clear the Print statements option. 

4. Select or clear the Print statements with a balance of $0.00 and no activity 
option. 

5. Under the Period heading, confirm the Closing Date. 

6. Click the Generate button.  
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Reprinting account statements 

You can reprint statements for all your customers with charge accounts or for a selected 
customer. The customer statements display detailed account information, including the 
payment due date, balance, minimum payment, credit limit, credit available, previous 
balance, and new charges. When you reprint statements, use the opening and closing date 
fields to specify the time period. 

To reprint an account statement 

1. On the Journal menu, click Close Billing Cycle. 

2. Select the Reprint a customer statement option. 

3. You can either accept the <all customers> default, or click the Browse  button 
to select the applicable customer account. 

4. Select or clear the Print statements with a balance of $0.00 and no activity 
option. If you want to print statements for only those accounts that have an actual 
balance, leave this checkbox blank. 

5. Under the Period heading, use the Opening Date and Closing Date drop-down list 
boxes to define the time period for which you want to generate the statement(s). 

6. Click Generate. 

7. When Store Operations displays a window confirming that you want to continue, 
click Yes. 

Note: If Store Operations cannot print statements based on the selection criteria you 
specified, you will see the Reprint Statements window notifying you that "no 
statements were found matching this criteria." 

8. After Store Operations has printed the statement(s), it will tell you how many 
statements, if any, were generated. Click OK.  
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Generating customer reports 
With Store Operations's report engine, you can generate a number of useful customer 
reports. Creating and maintaining detailed customer reports enables you to use the data 
as a foundation for mass-mailings, in addition to gathering and reporting information at 
the point-of-sale. For detailed instructions on how to sort, filter, and export report data, 
refer to the Generating Reports section. 

Customer List 

Store Operations can provide a detailed list of your customers that you can use to 
develop your mailing list. Generate the Customer List report by going to the Reports 
menu, clicking Customer, and then clicking List. After you specify the filter criteria, 
you will soon see a list of all your customers and their detailed account information, 
including account number, company, phone and fax numbers, credit limit, etc. On the 
report preview screen, double-click any of the account numbers to display the selected 
customer's detailed information. Tip: You can use the Crystal Reports (a Windows-
based reporting tool) menu option to generate customer mailing labels and customer 
lists. 

Accounts Receivable Report 
Generate either the Accounts Receivable Summary or Account Receivable Detailed 
report by going to the Reports menu, clicking Customer, and then clicking the desired 
report. After you specify the filter criteria, you will see a complete list of all your 
customers and their account numbers as well as their detailed account information, 
including activity (i.e., charge), invoice number and date, and total balance owed. Sort 
and filter the report data as desired. If you want to view a particular customer's detailed 
account information (i.e., purchase history, double-click on the account number to 
display the customer record. 

Top Customers Report 
Use the Top Customers report to see which customers are bringing in the most sales. To 
generate this report, go to the Reports menu, click Sales, click Top Performers, and 
then click Top Customers. The report includes information such as quantity sold per 
customer; total sales per customer; and total profit per customer. 

Regional Sales Report 
The Regional Sales report is a useful way to track customer demographics. For example, 
when you generate the report, Store Operations organizes the sales data by customers' 
zip codes. The report also displays the city, state, date, sales, and profit margin 
information, enabling you to identify your strongest and weakest demographics. You can 
then adjust your advertising efforts (i.e., direct mail) to focus on selected regions. To 



 

 Store Operations Userís Guide      91 

generate this report, go to the Reports menu, click Sales, and then click Regional Sales.  

Managing employees 

After you set up the basic employee information (i.e., cashiers, sales reps, etc.), you can 
continue to modify the data as needed. You can also assign each employee certain access 
privileges and control what they view or change in the Manager program. 

Read the following section and learn how to: 

! Manage cashier information 

! Send a message to cashiers 

! Track cashier attendance 

! Edit the time card 

! Generate Cashier Log report 

! Manage sales rep information 
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Managing cashier information 

In the Manager program, you can add, modify, and delete cashier names and 
information, in addition to assigning their access privileges. You can also generate 
different reports that display pertinent information about your employees' performance. 

Note: In order create, modify and/or delete cashiers, you must have Administrator 
Rights. The very first time you log onto the Manager program, you are given 
Administrator Rights. You could then create your cashiers and assign them with the 
applicable access privileges. 

To add a cashier to the database 

1. On the Database menu, click Cashiers. The Cashiers window appears. 

2. Click New. You can also click Copy to copy values from an existing record. 

3. In the Cashier Properties fields, enter the applicable contact information. 

4. In the Register Properties fields, enter the applicable register information. 

5. In the Security List box, select or clear the appropriate cashier rights. If you do not 
want the cashier to have Manager Rights or Administrator Rights, make sure those 
options are cleared (not checked). 

6. In the Over/Short Limits fields, define the over/short error limit amount or percent 
allowed for the cashier when the batch is closed. 

7. If you have defined your security levels, select the applicable level number in the 
Security Level drop-down list box. 

8. Click OK. You will see the new cashier listed in the Cashiers window. 
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To modify cashier information 

1. On the Database menu, click Cashiers. 

2. On the Cashiers window, select the applicable cashier, and then click Properties. 
You will see the Cashier Properties window. 

3. Edit the appropriate information, and then click OK. 

To remove a cashier from the database 

1. On the Database menu, click Cashiers. 

2. On the Cashiers window, select the applicable cashier, and then click Delete. 

3. Store Operations displays a window warning you that once you delete a cashier, you 
can not undo the operation. If you want to permanently delete the cashier from the 
database, click Yes. To cancel the operation and return to the Cashiers window, 
click No.  

Sending a message 
At any time, use the Manager program to send a message to one or more of your 
cashiers. If the cashier is currently logged on at a register, the message will appear on the 
POS screen shortly after sending. If the cashier is not logged on, the message will appear 
after the cashier logs on at any register. 

To send a message 

1. On the Utilities menu, click Messages. 

2. To create a message, click New. 

3. Click the To box to select the cashier who will receive the message. When you have 
entered the appropriate cashier, press the Tab key. 

4. In the Subject box, enter the appropriate subject heading. 

5. In the Message box, enter the applicable text. 

6. Click Send. The message notice will appear at the bottom of the screen when the 
cashier logs onto the system.  
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Tracking cashier attendance and payroll 

Store Operations enables you to track cashiers' attendance. This way, you can identify 
how many hours each cashier worked. Whenever you want to track cashier attendance, 
generate the Time Card report. 

If you want this report to display the correct data, make sure your employees are using 
Store Operations to punch in and punch out. Each cashier needs to use the CTRL-F12 
function key in the POS program to accurately log their hours. 

To generate the time card report 

1. On the Utilities menu, click Crystal Reports. 

2. On the Report Selection window, double-click on the Crystal Reports folder. You 
will see a list of reports in the Reports box on the rightmost part of the window. 

3. Select the Timecard Report, and then click OK. You will see a window that 
enables you to sort and filter report data. 

4. On the Sort By tab, select the desired sort level (i.e., Cashier ID, Cashier Name). 

5. On the Additional Details tab, select or clear the 'List Timecard Activities' option. 

6. On the Criteria tab, select the filtering criteria. 

7. Click Generate.  
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Editing time clock entries 

You can edit time clock entries directly in the Manager program. The Time Clock 
window provides detailed information about your employees' attendance, including the 
date and clock in/clock out entry times. The editing feature is especially useful whenever 
your cashiers log in under a different name or forget to clock in/clock out. 

Tip: To generate the Timecard Report, use the Crystal Reports option in the Utilities 
menu. You will find the Timecard Report file listed in the CrystalReports folder. 

To edit a time clock entry 

1. On the Database menu, click Time Clock. 

2. Select the cashier whose entry who you like to modify, and then click Properties. 

3. Using the available drop-down list boxes, modify the date and/or time information 
as necessary. 

4. Click OK. 

Note: You cannot change the cashier name. 

If you do not want a particular employee to edit clock in/clock out entries, you can easily 
restrict the employee's access to the time clock. 

To restrict employee access to time clock 

1. On the Database menu, click Cashiers. 

2. Select the cashier whose access privilege you want to define, and then click 
Properties. 

3. On the Cashier Properties window, select or clear the 'Allowed to edit Time Clock 
entries' and 'Allowed to view others' Time Clock entries' options, and then click 
OK.  
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Generating Cashier Log report 

To quickly see your cashiers' activity, generate the Cashier Log report. This report 
displays the cashier number and name, register, log in / out times, and activity hours. 

To generate the Cashier Log report 

1. On the Reports menu, click Miscellaneous, and then click Cashier Log. 

2. Sort and filter the data as desired.  

Managing sales rep information 
In the Manager program, you can continually modify your sales representatives' 
information, in addition to setting up their commission structure. You can also generate 
different reports that display pertinent information about your sales reps' performance. 

To add a sales representative to the database 

1. On the Database menu, click Sales Reps. The Sales Reps window appears. 

2. Click New. 

3. In the appropriate boxes, enter the sales rep's name, ID number, and phone number. 

4. Under the Commission heading, enter the Fixed Amount, Percent of Sale, and/or 
Percent of Profit amounts. 

5. Click OK to save the information. 

To modify sales rep information 

1. On the Database menu, click Sales Reps. 

2. On the Sales Reps window, select the applicable sales rep, and then click 
Properties. The Sales Representative Properties window appears. 

3. Modify the appropriate information. 
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4. Click OK to save the information. 

To delete a sales rep from the database 

1. On the Database menu, click Sales Reps. 

2. On the Sales Reps window, select the applicable sales rep, and then click Delete. 

3. Store Operations displays a window warning you that once you delete a sales rep, 
you can not undo the operation. If you want to permanently delete the sales rep from 
the database, click Yes. To cancel the operation and return to the Sales Reps 
window, click No. 

To track sales commissions 

After you define the sales reps' commission structure, you can track their sales 
commissions. 

1. On the Reports menu, click Sales, and then click Commission. The Commission 
report displays detailed information, including sales rep name and account number; 
the date the items were purchased; item pricing and quantity information; and the 
commission total for each item. 

2. On the report preview screen, sort and filter the data as desired.  
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Generating reports 

Store Operations enables you to generate active reports to display any type of 
information you need. The Manager program groups reports under specific categories, 
each containing additional reports. Using the report sorting and filtering tools, you can 
create virtually hundreds of custom reports. 

To create a report 

1. On the Reports menu, click the desired report category (i.e., Customer, Sales, 
Items), and then click the specific report. 

2. The Report Filter window appears and enables you to define the filter criteria. Be 
sure to click Add after each selected filter. 

3.  To generate the report, click OK. 

4. You will soon see the report preview screen. Sort the report data as desired. 

The following material provides in-depth instructions on how to: 

! Sort report data 

! Filter data attribute information 

! Adjust the header and columns 

! Add company logo 

! Access detailed information directly from report preview screen 

! Refresh data 

! Memorize report settings 

! Export report data 
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Sorting a report 

After you generate a report, you can sort the data directly on the report preview screen. 

Dragging columns 
Use your mouse to adjust the columns. For example, assume you just generated the 
Customer List report. On the report preview screen, you see that the report is sorted by 
customer account number. However, you want the report organized by customer name, 
not account number. 

You can organize the report by customer name. Just click-and-drag the mouse from the 
Name column to the Account # column. When you release the mouse button, the Name 
column should be comfortably resting in the first column position. 

Grouping data 
You can also group the report data in any way you want. After you generate the report, 

click the Select Columns to Group  button on the Store Operations Report 
toolbar. Use the drop-down list box to specify the columns whose data you want to 
group. Choose from grouping no data to grouping several columns. 

Expanding or collapsing data 
Store Operations includes an additional sorting tool that lets you customize your report. 
For example, you may not want to see all the categories for a particular department. 
However, you may still want that same report to display specific information for another 
department. With its advanced report tools, Store Operations enables you to pick and 
choose whatever data you want your reports to show. 

There are two ways you can expand (show) or collapse (hide) report data: 

! Using the toolbar - Use the toolbar buttons to quickly expand/collapse all the report 

data at once. Click the Expand All  button to display all the report data, or click 

the Collapse All  button to hide detailed report data. 

! Individually adjusting each group of items - Expand/collapse individual 
components. Each column contains a series of groupings. In the front of each group 
of data is a plus sign (+). To expand the group and see the data, click the plus sign 
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(+). If you want to contract the grouping, click the minus sign (-). 

 

Changing data order 
With a click of your mouse, you can change the sort order. When you sort by text fields 
(i.e., customer, items, etc.), entries are displayed in alphabetical order (A-Z or Z-A) 
based on the contents of the selected field. Likewise, value fields (i.e., total sales, 
number of visits, etc.) are sorted into numeric order (0-100 or 0-100) and date fields are 
sorted into chronological order (1/1/00-12/31/00 or 12/31/00-1/1/00). 

In order to sort entries in a column, click on its heading. Repeatedly clicking on the 
header will toggle between ascending and descending sorting.  
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Creating filters 

Use the filtering tools to quickly display specific information. A filter screens out any 
data that does not meet specific criteria (conditions). The report includes only those 
entries that match the set criteria. For example, you can generate a Customer List report 
and use the filtering tools to display only those customers that live within a certain zip 
code. 

You can set multiple criteria. For example, you can generate a report that includes 
customers that live in a certain city and who have purchased an item since a certain date. 

To specify the filter criteria, click the Filter Report Data  button on the Store 
Operations Report tool bar. The Report Filter window appears. 

Field: Use the list box to select a field. The fields vary according to the type of report 
you generate. 

Operator: Use the drop-down list box to select the conditional operator. The definition 
of each operator is as follows: 

Operator: Definition: 
= Equal 
< > Not Equal (Greater than or less than, but not 

equal to the value) 
> After (Greater than) 
< Before (Less than) 
> = After Including (Greater than or equal to) 
< = Before Including (Less than or equal to) 

Filter Value: Use this field to enter the text, number, or date that the information in the 
selected field must be compared to, according to the chosen comparison operator. 

For example, assume you just generated an Item Price List report, and you want to filter 
the data to display only those item prices for a particular supplier. To display this 
information, use filter criteria similar to the following: 

Field: Supplier 
 Operator: Equal (=) 
 Filter Value: (Name of Supplier) 

Click Add to enter these criteria in the Selected Filters box. Then click OK to generate 
the report. Note that the report criteria are case-sensitive. 



 

102      Store Operations Userís Guide  

Add button: Click Add to enter a new criterion, including the first one. After you click 
this button, Store Operations inserts that criterion into the Selected Filters box. The listed 
criteria form a brief but logical sentence describing its function. For example, assume 
you just generated a Customer List report, and you want to filter the report data to 
display only those customers that have visited your store less than 10 times. You enter 
the following settings: 

Field: Total Visits 
 Operator: Before (<) 
 Filter Value: 10 

After you click Add, you will see the filter criteria in the Selected Filters box, similar to 
the following: 

Total Visits < 10 

You can continue to add filter criteria by defining the field, operator, and filter value. 
Every time you click Add, Store Operations lists the additional criteria one after another 
in the Selected Filters box. When you finish selecting the filter criteria, click OK. You 
will see your new report in seconds. 

Remove button: Click Remove to delete a criteria in the Selected Filters box. To use 
this button, you must first select a criterion. If you want to delete all the filter criteria in 
the Selected Filters box, click Remove All. 

OK button: Click OK to generate the report using all the current settings. You will see 
the report, as it will be printed, on the screen where you can then sort the report data as 
desired. 

To set a filter criteria 

1. Click the Filter Report Data  button on the Store Operations Report tool bar. 

2. In the Field box, select a field name. 

3. In the Operator list box, select the operator. 

4. In the Filter Value box, enter the desired text or value. 

5. Click Add. 

6. After you specify the filter criteria, click OK to generate the report.  



 

 Store Operations Userís Guide      103 

Adjusting header and columns 

Store Operations gives you the flexibility to organize your data directly on the print 
preview screen. After you generate a report, you can adjust the header. To hide/unhide 
the header, go to the Store Operations Report toolbar and click the Hide/Unhide Report 

Header  button. 

You can adjust your report's columns in a couple ways. First, choose what columns you 
want to display or hide. Assume, for example, that you do not want your customers' 
phone numbers displayed on the Customer List report. After you generate this report, 
right-click your mouse and select Hide/Unhide Columns. 

You will then see the Options window where you can select or clear the appropriate 
column checkboxes. Using our example, clear the Phone # checkbox and then click OK. 
By displaying and hiding columns, you have complete control over what you and your 
employees can view on the reports. 
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Adding a logo 

Add your company logo or other graphic files to your reports. You will see the graphic 
on both your receipts and reports, provided that your printer is capable of printing 
graphics.  

Note: Use the Store Operations Administrator program to add the logo to your reports. 

To incorporate your company logo 

1. Open the Store Operations Administrator program. 

2. On the File menu, click Configuration. 

3. On the Store Operations Configuration window, click the Register tab. 

4. In the Number box, enter the applicable register number. 

5. In the Store Logo Filename box, enter the graphic file location. 

6. Click OK.  
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Directly accessing database information 

Store Operations introduces a handy tool that lets you access detailed database 
information directly from the report preview. This allows you to quickly look up or edit 
specific data without leaving the report screen. 

For example, assume you just generated an Item Price List report. On the report preview 
screen, you notice that the report is organized by department, category, item lookup 
code, description, etc. You decide you want to view and possibly edit a particular item. 

As you move the mouse over the report, you will see a magnifying glass  next to the 
cursor. The magnifying glass means that you can view or edit that individual report 
entry. 

Once you find the item whose information you want to edit, double-click your mouse to 
display the item's detailed information. For example, if you double-click on an item 
lookup code, you will see the Item Properties window for that item. Modify the data as 
necessary and then click OK. On the report preview screen, refresh the data to reflect 
recent changes. 

You can also use Store Operations's reports to drill-down to more detailed reports. For 
example, assume you just generated the Work Order (Summary) Report. If you want to 
see specific details regarding a particular order, double-click your mouse on the Order # 
field. You will soon see the Work Order (Detailed) Report for the selected work order.  
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Refreshing data 

As you generate reports, you may need to quickly reset your screen to incorporate 
continual changes and updates. Assume, for example, that you just generated a Customer 
List report. On the print preview screen, you notice that you need to update a particular 
customer's address. Double-click your mouse on the Account # box to pull up that 
customer's account information. You can then update the address and return to the 
Customer List report. 

At this point, the report still displays the old data. Refresh the screen to reflect your 
recent changes. On the Store Operations Report toolbar, click the Refresh Report Data 

 button to reset the screen. You will soon see the updated list. 

By using the report's refresh tool, you do not have to generate the same report twice. 
With one mouse click, Store Operations does everything for you.  

Memorizing report settings 

Store Operations lets you memorize (save) your report settings so that you can quickly 
generate the same report with the same exact settings. The memorized report(s) option 
will not appear in the Reports menu until you have memorized at least one report format. 
Once you memorize a report, you can locate it in the Reports menu. 

To memorize the selected report 

1. On the report preview screen, click the Memorize  button. 

2. On the Memorize Report window, enter the report name by which the report may be 
recalled. Click Memorize. 

3. When you see a window that tells you the report has been memorized, click OK. 

Tip: To generate the memorized report, go to the Reports menu, click Memorized, and 
then click the desired report.  
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Exporting a report 

After you generate an active report, you can export the report data into one of its 
supported formats, such as HTML, Tab delimited, Comma delimited, and XML. For 
example, you can export data into Microsoft Excel in order to add to or change the report 
information for a particular client or company. 

To export a report 

1. On the Report Preview window, right-click your mouse and select Export. The 
Export window appears. 

2. In the Destination box, select the method by which you will export data. You can 
select from e-mail, application, or file. 

3. In the File Format box, select the type of text file to which you will export data. For 
example, to export the data into Excel, you can select the Comma delimited option. 

4. Click OK. 

5. If you selected "application" or "file", you will see the Save As window where you 
can enter the file name, and then click Save. When Store Operations displays the 
Export window notifying you of the number of rows that were exported, click OK. 

If you selected "e-mail", Store Operations will automatically open your e-mail 
program and generate an e-mail message with the attachment of the report in the 
format you specified.  
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Using labels 

Use the Label Wizard menu option in the Wizards menu to print your labels. The Label 
Wizard guides you quickly through the label printing process. 

Additionally, you can use the Label Designer menu option in the Utilities menu to 
design label templates. The Label Designer offers various tools that allow you to edit 
existing label styles or create the templates from scratch. After you save the customized 
label template, use the Label Wizard to select the template that Store Operations will use 
to generate the label(s). 

Read the following and learn how to: 

! Generate Labels 

! Design Label Templates 

To gain a better idea about the types of labels you can design, review the Sample Labels 
topic.  

Generating labels 

Use the Label Wizard whenever you want to generate labels for selected items. If you 
used the Label Designer to create/edit label templates, you can use the Label Wizard to 
specify the desired template. 

To generate labels 

1. On the Wizards menu, click Label Wizard. 

Note: You can also access the Label Wizard by clicking the Labels button on the 
applicable windows (e.g., the Item Properties window for a selected item). When 
you click this button, you will see a window that lets you define additional filter 
options. 

2. In the Select Item Range window, select the type of items for which you want to 
generate labels. For example, choose items from a particular department/category by 
selecting the Print labels for items belonging to a Department and Category 

option, clicking the Browse  button, selecting the applicable 
department/category, and then clicking OK. 



 

 Store Operations Userís Guide      109 

3. Under Selection Options, select or clear the appropriate options, and then click 
Next to continue. 

4. Specify which items to generate labels. To copy (add) all the items from the 
Selection List to the Print List, click Add All. To add selected items, click on the 
applicable item in the Selection List, and then click Add. Store Operations will add 
the items to the Print List.  

Tip: To quickly add multiple items to the Print List, press and hold the Control key 
and use the mouse to select the applicable items.  

5. Select the method by which the Label Wizard will determine the number of labels to 
print for each item, and then click Set Quantity. For example, if you want to print 
12 labels for each item, select the Fixed Quantity option and enter the number "12" 
in the box, and then click Set Quantity. 

6. Click Next to continue. 

If you chose I want to print labels by scanning an item in the Select Item Range 
window, the Scan Items window will appear and you can scan the items you want 
to generate labels for and choose the number of labels. 

7. The next window enables you to select the label format you want to use to generate 
the labels. If you used the Label Designer to create/edit a particular label template, 
select the template from the Label Format list. Note that you will not be able to 
view the Barcode Blaster labels. 

8. Click Print. 

9. When Store Operations displays the Creating Print Preview window, click OK. 

10. You will see the print preview of the labels. To define the page setup options, click 
the Page Setup icon on the toolbar, modify the applicable settings, and then click 
OK. 

11. To confirm or edit the print options, click the Print Setup icon on the toolbar, 
modify the applicable settings, and then click OK. 

12. To generate the labels, click the Print icon on the toolbar. 
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Designing label templates 

The Label Designer enables you to design your own label templates. A template is 
essentially a format Store Operations will use to arrange fields of information (e.g., item 
description, barcode, and price) on a label. 

You can also modify the label properties, such as label height, width, and number of 
rows/columns. This way, you can define how many labels you want to print on a page. 

Each field of information on a label template is an "object". Whenever you design or edit 
label templates, modify these objects using the object property boxes and/or your mouse. 

There are two ways to create a label template. You can either create a label from scratch 
or use a sample label style that contains the format you want to reuse. We recommend 
that unless you are very experienced with designing labels you start with a sample label 
file. This way, you can quickly modify and fine-tune the template. 

Read the following and learn how to: 

! Define the label format properties (e.g., height, width) 

! Insert label objects (e.g., graphic, barcode, text) 

! Adjust the size and positioning of label objects 

! Create a label template from scratch (a tutorial) 
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Defining the label format 

Sometimes, individual printer drivers may interpret the label format slightly different 
than other printers. Whenever you want to adjust the alignment format for printing 
labels, use the Label Designer. The label properties, such as height, width, and row 
space, determine the label format. 

To define the label format 

1. On the Utilities menu, click Label Designer. 

2. To open a sample label style, click the Open  button on the Label Designer 
toolbar. The sample label files are included with Store Operations and are located in 
the Labels folder of the EXE sub-directory. 

3. Specify the file name (i.e., 12-295.lbl), and then click Open. The label file should 
have .LBL as the extension. The Label Designer window will then display the label 
properties for the template you selected. 

4. For the Units heading, select the unit of measure (twips, inches, or cm) you want to 
use. 

5. For the Description heading, use the available entry fields to adjust the properties. 
Whenever you adjust the Label Height or Label Width, you will see the updated 
template. 

6. If you want to save the format, click the Save  button. 

7. On the Save As window, enter the description in the File name box. Or, you can 
accept the existing name. 

8. Click Save. You can then insert and/or edit label objects.  
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Inserting label objects 

Whether you create your label from scratch or modify a sample label template, you can 
add different types of objects, such as text, fields, barcodes, boxes, lines, and pictures. 

Although the following example shows you how to add a picture to the label template, 
the standard procedures for inserting an object (e.g., object, text, or box) are similar. 

Tip: Use your mouse to quickly resize your label objects. Whenever you add objects to 
your labels, right-click your mouse on the desired object. As you hold down the mouse 
button, move your mouse to resize the object. 

To add a graphic file to the label template 

1. On the Utilities menu, click Label Designer. 

2. To open a sample label style, click the Open  button on the Label Designer 
toolbar. The sample label files are included with Store Operations and are located in 
the Labels folder of the EXE sub-directory. 

3. Specify the file name (e.g., 12-295.lbl), and then click Open. The label file should 
have .LBL as the extension. The Label Designer window will then display the 
label's description (e.g., Avery Label 12-295), property information, and graphical 
layout. The following sample label displays some of the standard label objects. 

4. Click the Insert Object  button on the Label Designer toolbar. Store Operations 
inserts the Caption field on the label template. 
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5. Click on the Caption field. At this point, you can use the Type drop-down list box 
on the Label Designer window to assign the object property (e.g., Text, Barcode). 
Because you want to add a graphic file, use the Type field to select Picture. 

6. To select the graphic file, click the Browse  button in the Caption drop-down 
list box. 

7. On the Open window, specify the file name, and then click Open. You will see the 
graphic on the label template. 

8. Under the Object Properties heading, use the Top, Left, Height, and/or Width 
fields to position and size the graphic. You can also use the mouse and click-and-
drag the object to the desired position. 

Note: Depending on where you want to place the graphic, you may have to use the 
Object Properties fields to adjust the position and size of the other objects. 

 

9. To save the format, click the Save  button. 

10. On the Save As window, enter the description in the File name box. Or, you can 
accept the existing name. 

11. Click Save. 
Note: Your printer may not be able to use label graphics. Refer to your printer's manual 
for more information.  
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Adjusting size and position of label objects 

One of the ways you can edit a label style is to adjust the size and positioning of the label 
objects. You may want to resize the text box so that your printer does not chop off the 
first line of text. Or, you might want to decrease the size of the barcode and enlarge your 
store name field. Use the Label Designer to modify the object properties. 

To adjust the object size and position 

1. On the Utilities menu, click Label Designer. 

2. To open a sample label style, click the Open  button on the Label Designer 
toolbar. The sample label files are included with Store Operations and are located in 
the Labels folder of the EXE sub-directory. 

3. Specify the file name (e.g., 5161.lbl), and then click Open. The label file should 
have .LBL as the extension. The Label Designer window will then display the 
label's description (e.g., Avery Label 5161), property information, and graphical 
layout. The following sample label displays some of the standard label objects. 

 
4. Click on the object (e.g., Barcode, Price Field) whose properties you want to 

modify. For this example, click the Barcode on the label layout. 

5. Under the Object Properties heading on the Label Designer window, modify the 
applicable Top, Left, Height, and/or Width fields. Once you adjust the number(s), 
you will see the updated graphical layout. You can also use your mouse to adjust the 
positioning of the objects. Just click-and-drag the object to the desired position. 
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6. If you modified the label and want to save the format, click the Save  button. 

7. On the Save As window, enter the description in the File name box. Or, you can 
accept the existing name. 

8. Click Save.  

Creating label template from scratch 

You can create a label template without using an existing label style. We recommend, 
however, that you first practice using the sample label styles included in the Store 
Operations EXE sub-directory. 

Use the following tutorial to learn about all the label objects and their associated 
functions. 

To create a new label template 

1. On the Utilities menu, click Label Designer. 

2. On the Label Editor window, click the New  button. 

3. In the Description field, enter the name by which the label template will be 
referenced. 

4. For the Units heading, select the applicable unit of measurement (Twips, Inches, 
Cm). 

5. Use the Label Properties fields (e.g., Label Height, Label Width, Rows) to define 
the label format used for printing. When you enter the Label Height/Width, you will 
see the layout on the right side of the Label Designer window. 

6. On the Label Designer toolbar, click the Insert Object  button. You will see a 
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Caption box appear on the label layout. 

7. Click on the Caption field you just inserted onto the layout. You can then edit the 
Object Properties. 

8. In the Name field, enter the name (e.g., Barcode) by which the object can be 
referenced. 

9. Using the Type drop-down list box, select the type of object you are creating. For 
this example, select Barcode. 

10. On the layout screen, use your mouse to click-and-drag the barcode object to the 
desired position. 

 

11. In the Label Height and Label Width fields, enter the applicable measurement. 

12. To add another object, click the Insert Object  button again. You will see a 
Caption box appear on the label layout. 

13. Click on the Caption field you just inserted onto the layout. 

14. In the Name field, enter the name (e.g., ItemLookupCode) by which this object can 
be referenced. 

15. Use the Type drop-down list to select Field. 

16. Use the Caption drop-down list to select Item LookUpCode. 

17. On the layout screen, use your mouse to click-and-drag the Item LookupCode object 
to the desired position. 

18. Under the Object Properties heading, use the applicable fields to adjust the object's 
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height and width. 

19. Click the Font  button to define/modify the font name, style, color, and style. 

20. Use the alignment buttons to align the text. 

21. To add another object, click the Insert Object  button again, and follow steps 13-
20 to create a Price object. 

 

22. To add another object, click the Insert Object  button again. 

23. Click on the Caption field you just inserted onto the layout. 

24. In the Name field, enter the name (e.g., Text) by which this object can be 
referenced. 

25. Use the Type drop-down list to select Text. 

26. Use the Caption field, type the text as it will appear on the label (e.g., "Always the 
Best Price!"). 
Tip: Ensure that your Text field is slightly larger than the selected font size; 
otherwise, the text will not print. 

27. On the layout screen, use your mouse to click-and-drag the Text object to the 
desired position. 

28. Under the Object Properties heading, use the applicable fields or your mouse to 
adjust the object's height and width. 

29. Click the Font  button to adjust the font name, style, and size. You can also use 
the alignment buttons to position the text. Note that your text field should be slightly 
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larger than the font size; otherwise, the text will not print correctly. 

30. To add another object, click the Insert Object  button again, and follow steps 13-
20 to create both a Store Name object and Description object. Make sure to select 
the Type and Caption fields that are applicable to the object you are creating. 

31. To add a picture to the label, click the Insert Object  button again. 

32. Click on the Caption field you just inserted onto the layout. 

33. In the Name field, enter the name (e.g., Picture) by which this object can be 
referenced. 

34. Use the Type drop-down list to select Picture. 

35. In the Caption field, click the Browse  button. 

36. On the Open window, specify the applicable graphic File name, and then click 
Open. 

37. On the layout screen, use your mouse to click-and-drag the graphic object to the 
desired position. 

38. Under the Object Properties heading, use the applicable fields to adjust the object's 
height and width. 

39. To add a picture to the label, click the Insert Object  button again. 

40. Click on the Caption field you just inserted onto the layout. 

41. In the Name field, enter the name (e.g., Box) by which this object can be referenced. 

42. Use the Type drop-down list to select Box. 

43. On the layout screen, use your mouse to click-and-drag the graphic object to the 
desired position. 

44. Under the Object Properties heading, use the applicable fields to adjust the object's 
height and width. 
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45. To save this label template, click the Save  button on the Label Designer toolbar. 

46. On the Save As window, enter the description in the File name box. You must save 
this label file in the Labels folder of the Store Operations EXE sub-directory. 

47. Click Save. 

You can now use this template in the Label Wizard to generate labels.  

Sample labels 

The following are just a few of the many ways you can customize your labels. Note that 
some of these graphic labels may not be printed depending on your printer capabilities. 

Use only the barcode and item lookup code 

 
Display a picture of the item 
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Display your company logo 

 
Display sale prices and text messages 

 
Include detailed item information, such as the serial number 

 
Display all the currency rates for a selected item 


